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The Ap pleShare file server is the 
Macintosh Plus with one or more 
hard disks that is connected to 
the AppleTalk network and has 
AppleShare file server so ftwar e 
installed. 

The words file server and server 
are used interchangeably in this 
guide. 

Preface 

Interpersonal Computing 

If you r Apple® Macintosh™ compute r is part of a group of 
Macintosh compute rs connected to the AppleTalk® Personal 
Network, you're probably already aware that AppleTalk is fo r 
sharing-for exa mple, sharing a Lase rWrite r® pri nte r to prin t 
pu blication-quali ty reports o r le tte rs. Now Macintosh users ca n 
share information over the AppleTalk network-whe n you set up an 
AppleS hare™ file server. 

The AppleShare file server will qu ickly become the center of desktop 
communica ti ons in you r offi ce. Use rs ca n both store and share 
Macintosh documents, folders, and applicatio ns o n the server. 
AppleShare also lets users have personal control over how they 
share their information. Users can decide w ho will see or use what 
they've stored. For exa mple, AppleShare lets you set up the server 
so a user can store a report in a private folder so no one else can see 
it or make changes to it. But at any ti me, the user also can make the 
report available to others w ho have access to the server. With 
AppleShare, each Macintosh is a powerful desktop communications 
too l. 
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About this guide 
This guide shows you how to be the administrator of Lhe 
AppleShare file server. Your first task wi ll be to set up the fil e se rve r 
and get users ready for using it to store and share documents, 
folde rs, and applications. The n you 'll lea rn how to make it poss ible 
for users to control access to their information. And because you 
are the administrator, you' ll lea rn ways to keep track of h ow the 
server is being used so you can help keep everyone on the network 
working efficiently. 

o Chapter 1 tells you about AppleShare and shows you how to set up 
a Macintosh Plus computer as an AppleSha re fil e se rve r. 

o Chapter 2 tells you how to set up the file server so users ca n 
control access to the information they store on the serve r. 

o Chapter 3 shows how to keep track of how the file se rver is used 
and how to make changes to keep it running smoothly. 

o Chapter 4 summarizes all the basic tasks that an administrato r 
may need to do. 

o Chapter 5 is a refe re nce that includes a summary of commands. 

o Chapter 6 shows you how to do simple tro ubleshooti ng. 

o A glossary of technical terms and an index are also incl uded. 

What you need to know to use this guide 

You need to be familiar with basic Macintosh vocabu lary and ski lls 
to use this guide. If opening o r dragging icons, initializing disks, 
and using folders to arrange documents and applications in a 
hie rarchy are unfamiliar tasks, you can lea rn these Macintosh basics 
by using the Guided Tour disk and cassette tape that came with you r 
Macintosh Plus, and by reading Macintosh Plus, you r owne r's guide 
(particularly the sectio n o n "Using the Finder to Manage 
Documents, Folde rs, and Appli ca tions "). 

Besides this Administrator's Guide, the re are two othe r gu ides that 
you need to keep close at hand. 

Preface : Interpersona l Computing 



You'll learn about creating and 
using these reports in Chapter 3. 

o The AppleShare User's Guide describes how to use the file server 
as a user at a work station. You need to be familiar with this guide 
because, as the administrator, you' ll be answering users' 
questions and helping them to access the server. And you' ll 
probably want to access the server yourself as a user from a work 
station. 

o AppleTalk Personal Network is the guide that comes wiLh the 
AppleTalk System Connector Kit, which you use to connect the 
server to the AppleTalk network. If something goes wrong with the 
network, you can use this guide to help with troubleshooLing the 
problem. 

Do you have what you need? 
To set up the AppleShare file server, you need: 

o an Apple Macintosh Plus computer. Once this Macintosh Plus is 
being used as a file server, you cannot use it as your personal 
computer. You must "dedica te" this Macintosh Plus to being a 
fil e server. 

o one or more hard disks, such as the Macintosh Hard Disk 20 or 
Apple Hard Disk 20SC. See your authorized Apple dealer to find 
out which drives made by other manufactu rers are compatible 
with AppleShare. 

o the AppleTalk System Connector Kit for the Macintosh Plus that 
will become the file server. It is assumed that the AppleTalk 
Personal Network is already installed. 

o the AppleShare Server Installer disk 

o the AppleShare Work Station Installer disk 

o the AppleShare User's Guide 

To open and print reports that help you keep a record of what's 
happening on the server, you also need: 

o a word processing application, such as the MacWrite™ 
application 

o a printer 

Do you have what you need? xi 
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A work station is a computer-in 
this case. the Macintosh- that 
you can use to do your work and 
send or receive information over 
a network-in this case. the 
AppleTalk Personal Network. 

A hard d isk attached to the 
Macintosh Plus that's runn ing 
AppleShare server software is 
called a volume . 

This chapte r begins by introduci ng the AppleShare fil e server and 
defin ing some of the words you'll encounte r as you set it up--words 
li ke work station and volume. Then you' ll se t up the equipment for 
the serve r, get it ready fo r s to ring in formation, and make it 
avai lable to the users on the network. 

About the AppleShare file server 
Your office probably has many Macin tosh work stations that arc 
connected to the AppleTalk network so they can share office 
equipment economica ll y. For example, you may be sharing a 
Lase rWrite r to print documents . With AppleShare, work stations 
can have access to the AppleShare fil e server-a Macintosh Plus, 
also on the network, that has one or more hard disks used 
exclusively for s to ring and sharing informatio n. This Macintosh 
Plus becomes a fi le se rver on ly afte r you prepare it by installing 
AppleS hare software. 

When you make the file server available to users on the network, for 
the most part users will use the server's hard disks, known as 
volumes, just like they've used any Macintosh disk drive. After they 
se lect a volume, its icon appears on their Macintosh desktop. After 
they open it, they ca n then (for exam ple) create fo lde rs and save 
documents on the volume. 
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A folder is own ed by the user 
who crea tes it. 

In Chapter 2. you'll learn how to 
register users so they can set 
access privileges for the fo lders 
they own. You'l l also learn how 
to create groups of re gistered 
users. so the owner of a folder 
can g ive a group access to a 
folder's contents. 

I; I! 
[::==; =~1 1 

rr; ?Sn 
In this way, the fi le server acts like a filing cabinet shared by a group 
o f people . For example , if membe rs of an organiza tion wa nt to 
share news or research findings, they can sto re the document in a 
fo lde r on the serve r, and the ir colleagues can open it and read it at 
their work stations-and can even add comme nts to the document. 

As the administrator, you can also set up the server so it works like a 
locked filing cabine t, as if there were locks o n individu al fo lde rs 
within the cabinet. Then only certain users on the ne twork can ope n 
a particular folde r. To do this, you must crea te a list of registered 
users on the server and assign them passwords. 

AppleShare the n le ts registe red users cre ate folders on the se rver 
and give or withhold from other users access to what's in each 
folde r. The user (who is the owner of a fo lder) se ts access 
privileges for each fo lde r. With access privileges, a user ca n keep 
a fo lder private, make it ava ilable to only a certain group of 
people, or make it available to everyone on the network. The use r 
ca n even decide who, if anyone , can make changes to the contents 
o f a folde r. 
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You 'll begin by setting up the server so all users on the network can 
store info rmation on the server's volumes, and so the info rmatio n 
they sto re will be available to all users-if they have AppleShare 
software . 

If your organization requires that users be able to se t access 
privileges to keep the info rmation in their fo lders p rivate, you'll go 
on to Chapte r 2, "Privacy on the File Serve r. " 

After setting up the file server and access privileges (if you need 
them), you 'll want to read Chapte r 3, "Keeping the File Server 
Running Smoothly." 

Choosing a secure place for the server 
Before you unpack and set up the file server equi pment-the 
Macintosh Plus and the hard disk drives-choose a secure p lace to 
set it up. 

AppleShare lets you set up access privileges and protect 
info rmation from being accessed over the network , but you cannot 
p revent someone from tampering w ith what's s to red o n the server if 
that pe rson has physical access to the serve r volumes. For examp le, 
if a server volume is physica lly removed from the server and then 
connected to a Macintosh Plus somewhere else, access privileges 
have no effect, and all folders and docu ments stored on that 
volume can be opened. 

Warning Set up the seNer in a secure p lace. Perhaps choose a room to 
w hich only you have access. 
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Setting up equipment for the server 
For each piece of equipment you' ll be using as part of the server, 
read the unpacking instructions and re fe r to the owner's guide if you 
have questions about setting it up. 

•:• Note: If the Macintosh Plus that you p lan to use as the file 
server is already part of your AppleTalk network, you may want 
to skip to the section "Getting the File Server Ready." 

1. Choose a secure place for the server. 

2. Set up the Macintosh Plus that will be the file server. 

Following the instructions in you r Macintosh Plus owner's guide, 
attach the power cord to the Macintosh Plus and p lug the other 
end into a grounded outlet. Then attach the keyboard and 
mouse. If you haven't used a Macintosh before, now's the time to 
read the owner's guide or take the Guided Tour. 

3. Switch off the Macintosh Plus if you've turned it on . 

4. Attach one or more hard disks to the Macintosh Plus. 

Follow the instructions in your hard disk owner's guide. You can 
attach up to nine hard disks in all-up to two Hard Disk 20s or 
their equivalent, and up to seven Hard Disk 20SCs or other SCSI 
(Small Computer System Inte rface) drives. 

5. Connect the Macintosh Plus to the AppleTalk network. 

AppleTalk Personal Network, the guide that came with your 
AppleTalk System Connecto r Kit, te lls how to set up an AppleTalk 
network and how to add a new device to the network. 

The file server can be anywhere on the network-it doesn't have 
to be at one end of the network or another. 
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You'll soon use AppleShare 
Admin to prepare the startup 
volume, which will contain all 
the necessary system and 
AppleShare files so the 
Macintosh Plus can start up as a 
file server. 

Getting the file server ready 
Now that you 've set up the Macintosh Plus and hard disks and added 
the Macintosh Plus to the AppleTalk network, you're ready to switch 
on the hard disks and start up the Macintosh Plus with the 
AppleShare Seroer Installer disk. As necessary, you'll initialize and 
name any new hard disks, and then you'll use the AppleShare 
Admin application to select one hard disk as the server's startup 
volume. Next, you'll give the server a name and specify an Admin 
key-a secret word that only you should know. That's so only you 
can use it again to open the AppleShare Admin application to keep 
track of how the server is used and to make changes to keep it 
running smoothly. 

Naming server volumes 

Once the server is running, the names you give the hard disks will 
appear over the network as the names of the volumes on the server. 
(You won't need to divide single disks into multiple "volumes.") 
The following instructions assume you're naming a Macintosh Hard 
Disk 20 or Apple Hard Disk 20SC. If you've attached another kind of 
hard disk, see its owner's guide for instructions. 

1. Switch off the Macintosh Plus if it 's on. 

If you're currently using the Macintosh Plus, return to the finder, 
choose Shut Down from the Special menu, and switch off each 
hard disk before switching off the Macintosh Plus. 

2. Switch on all hard disks attached to the Macintosh Plus. 

You can switch them on in any order. 

3. When all disks are up to speed, insert the AppleShare Server 
Installer disk into the built-in disk drive, and switch on the 
Macintosh Plus . 

If you 're not sure how to tell when a disk is up to speed, see its 
owner's guide. 
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Afte r a few seconds , the Server Installer disk icon appea rs in the 
top-right corner of the desktop, followed by the icon and name 
of each previously initialized hard disk. 

If any of the hard disks has not been initialized, you'll be asked if 
you want to initia lize it. If you've attached an uninitiali zed I-lard 
Disk 20SC, you must use the I-ID 20SC Installe r application to 
initialize it. See your owner's guide for the Hard Disk 20SC fo r 
instructions. 

If no disks need to be initialized, skip to the next section o n 
"Specifying the Server Startup Volume." 

4. Click Initialize. 

After a few minutes, you're asked to name the disk. If the disk 
doesn't initialize properly, see its owne r's guide. 

5. Type a disk name, up to 27 characters long. 

You can use any character except a colon (:). 

6. Click OK. 

7. Repeat steps 4 through 6 until all disks are initialized and 
named. 

Be sure to give each disk a unique name. 

After a disk is initialized and named, its icon and name appear 
on the desktop . 

from here on, as you begin to insta ll AppleShare softwa re, the hard 
disks will be known as volumes. 

Specifying the server startup volume 

When you install AppleShare software , a special folder, ca lled the 
Server Folder, is crea ted o n each serve r volume. These fo lde rs 
contain informatio n about the volumes. The server needs this 
info rmation to operate. The serve r startup volume has additional 
information in its Server Folder. The server needs this 
in fo rmation-which includes the AppleShare serve r application 
and re lated files-to sta rt up. 
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You use the AppleShare Admin 
application to install the 
AppleShare server software . 

Your AppleShare Server Installer disk conrai ns an appli ca rion 
program called AppleShare Admin. You'll use AppleShare Admin 
to specify which server volume will be the startup volume. Then 
AppleShare Admin will create a Server Folder and install the 
AppleShare serve r software in that folder. 

1. Open the Server Installer disk icon if it's not already open. 

Select the disk icon and choose Open from the File menu , or just 
double-click the disk icon. 

s File Edit Uiew Special 

Seruer Installer 
2 items 560K m disk 

0 
Sy stem Folder 

International Sal€' 

2. Open the AppleShare Admin icon. 

Select the icon and choose Open from the File menu, or just 
double-cl ick the icon. 

AppleShare soon presents a dialog box with an alphaberized list 
of the server volumes that are attached to the Macinrosh Plus. 
You're asked to select one of them to be the server startup 
volume. 
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Available volumes 

3. Click the volume that wi ll be the server startup volume . 

Scroll the list, if necessary, to find the name you want. 

[13 No startup uolume found. Please select a 
uolume to be the file seruer's startup uolume . 

~ . .L. 
=· Amen can Sa I es lL lQ. ~ OK D L 

[ 
-~ 

kB ( Finder ) 

4. Click OK. 

A message asks you to confirm that it's okay to prepa re the sta rtup 
volum e. 

5. Clic k OK. 

The uolume "International Sales" needs 
to be prepared for use by AppleShare. 

f Finder 

A series of messages te lls you that AppleShare Admin is 
preparing the startup volume. 

Afte r AppleShare Admin creates a Server Folder and copies to it 
the files needed to start up and run the server, AppleShare 
Admin checks to see if the volume has a Use rs & Groups 
fi le-which would include a list of server users. Because the 
server is being set up fo r the first time , there is no such file . And 
because a startu p volume must have a Users & Groups fil e, even 
one without a list of names, you'll create the file now. Later, if you 
decide to go on to Chapter 2, you'll registe r users, and their 
names w ill be added to the file. 
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The name you give the file 
server will appear over the 
AppleTalk network. 

rf':ll No Users !} Groups file found. Please select a saued 
l.C Users G Groups frle or click New to create one: 

I·=• International Sales I 
= lnternati ... 

Ne w l;J 
Finder J Uolume 

6. Click New. 

AppleShare Admin creates the Users & Groups file and saves it in 
the Server Folder on the startup volume. 

Naming the server and choosing 
the Admin key 

Now you're asked to give the file se rve r a name. To help users know 
which server to choose when there 's more than one avai lable, you 
might give the server the name or location o f your depa rtme nt, 
such as "Sales & Marketing" or "Second floor West." 

You'll also enter the Admin key, which you must type each time you 
want to open the AppleShare Admin applicatio n. (For this reason, 
the key is ca lled the Admin key.) Because AppleShare Admin lets 
you get access to all the folders that are stored on the server, 
including the ones containing users' p rivate docu ments, it is 
impo rtant to keep the Admin key confide ntial. 

1. Type a name for the server. Don 't press Return. 

Each file server must have a unique name. 

A serve r name can be up to 31 characters long. 
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2. Press Tab, and type the key. 

The key can be up to eight characters long. 

~ Please enter file seruer information: 

The server name you typed ____ ___, ______ .-------------~ 
Senoer Name: f Sales Ir "1arketing 

The Admin key you typed ------------
Admin Key: f sesam~ I 

Finder 

Warning Memorize your Admin key, and write it down exactly as you 
typed it and keep it in a sa fe place. You will never see it again 
on the server, and there is no way to find out what it is. 

Keep the key confidentia l. Anyone w ho has an AppleShare 
Server Installer disk and knows the Admin key of your server 
could use AppleShare Admin to access information on the file 
server-including information about users a nd groups-and 
could make changes to it. They could also change information 
about folders, including folder's names, owners, and access 
privileges. 

Each time you use the key, you must type uppercase and 
lowercase characters exactly as you typed them now. 

3. Click OK. 

A message asks you to make su re that you've typed the key exactly 
as you want it. 

The Admin key will be required before 
AppleShare Admin can be used again. 
Are you sure that it is correct? 

[Cancel) 
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4. Click OK to confirm the key as you typed it, or click Cancel 
to return to the dialog box and make changes. 

If you click Cancel, you can make changes to the server name as 
well as the key. 

Once you've clicked OK, AppleShare Admin finishes preparing 
the server. This may take several minutes. During this time, 
several messages appear on the screen and tell you what 
AppleShare Admin is doing. Some messages appear o nly 
brie fly, but don' t worry about reading them. 

Preparing additional volumes 
If you've attached more than one hard disk (volume) to the fil e 
server, a dialog box appears for each additional volume and asks 
you abou t p repa ring it for use with the server. 

The uolume "American Sales" needs to be 
prepared for use by AppleShare. 

[ Skip Llolume J 

• For each volume you want to prepare, click OK. 

A series of messages confirms that AppleShare Admin is 
preparing the volu me. 

• For each volume attached to the file server that you don't 
want to use as a server volume, click Skip Volume. 

A skipped volume will never be available over the network. 

You' ll probably use this option only if you left a hard disk 
(volume) attached to the server bu t you really don't want to use 
the disk as a server volume. Later, when the server is shut down 
and the equ ipment is switched off, you can unconnect the 
"skipped volume" from the server. 
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Like a folder. a volume can have 
an owner who can set access 
privileges for that volume. 

When AppleShare Admin has prepared all the volumes, several 
menu names appear in the menu bar at the top of your screen. They 
contain commands you'll use for working with the server when it's 
shut down and not available on the network. (You'll learn about 
using these commands in Chapters 2 and 3.) 

Giving the custodian a name and password 
AppleShare Admin has also opened three windows: the User List, 
the Group List, and a user information window. In front of them is a 
dialog box tell ing you that you need to enter the name and password 
of the server's custodian . 

• File Edit Us en Groups Seruer IJolumes Folders 

User List User: Custodian 
Us.:-r N<imo? -= 

[] ' 11 
[) - I [ID You must enter the custodian's name 

and password. This user will own all 
unassigned folders. 

~ 

~ OK;l 
Gn·u~· N .. m.:-

I I I 

r--1 

Every server must have a user known as the custodian. \'V'hen 
A ppleShare Admin prepares the server, the custodian becomes the 
owne r of the prepared volumes and any folders that were already on 
the hard disks before AppleShare Admin prepared them. And late r, 
if the server's record of who owns a folder is incomplete, the 
custodian will become the owner of that folder. In this sense, the 
custodian is really a caretaker who looks after all unowned fo lders on 
the server. 
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For now, you'll choose a custodian name and password. Later, if 
you need to, you can always use AppleShare Admin to re name the 
custodian. 

1. Click OK. 

The dialog box goes away, and the user information window is 
active. 

Pas sword: I~--~ 

OK I HP!!Prt ) 

Primary Group: 

Group list Groups: 

Gr-•:otJp Name 

You must remember the custodian's name and password. To 
access the server as the custodian, you must type a name and 
password from a work station. The custodian is, in fact, a 
registered user, and you'll learn more about this in Chapter 2. 

Notice that "Custodian" is already shown as the user's name in 
the User List window, next to the custodian icon. You can either 
keep that name or enter a different one. 

2. If you want to use "Custodian " as the custodian 's name, go 
on to step 4. 
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3. Type a different name tor the custodian . Don 't press Return . 

The name can be up to 31 characters long. 

4. Press Tab, and type a password up to eight characters long. 

Don't leave the password blank, or anyone will be able to access 
the server as the custodian just by using the custodian's name . 
And don't use a password that others on the network can easily 
guess, such as a last name or nickname. 

As you type, each character appears as a large dot. If you think 
you've made a typing error, select the enti re password and 
retype it. 

•:• Note: The password is not the same as the Admin key. All 
registered users, including the custodian , have a password. 
Passwords are used when registered users access the server over 
the network. The Admin key is used only by the administrator to 
open AppleShare Admin when the server is shut down. 

Warning Write down the custodian 's password exactly as you typed it. 
and keep it in a safe place. The password never appears again. 
Each time you try to access the seNer from a work station as 
the custodian , you must type the password exactly as you 
typed it here-with the same uppercase and lowerc ase 
c haracters. 

Selecting a server from a work 
station and identifying yourself 
is called logging on. 

5. Make sure the Login Enabled option is selected. 

The Login Enabled option indicates whether the user named 
in the window is allowed to log on to the server. Click the 
option to se lect it if it's not selected. 

Getting the fi le server ready 15 



Custodian name you typed 

Custodian name cha 
list of server users a 

nged in 
fter you 

clicked OK 

Password you typed 

When selected. the c 
named in the window 
on to the server 

ustodian 
can log 

[J 
D 
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6. Click OK . 

• File Edit Users Groups Serner Uolumes Folders 

User List D User: Alan 
Use-r Name 

[J ""' D Any User 
Name:1[Alan J -D Alan 

Pmw,.~Jt····~ Logi" '"'"'" 

I L _J I 1 •• ,,.:.!..' I 
-~ 

Primary Group: J L J 
Group List ,,,,,. I 

I I 

t 
Group N::im~ 

t--

On the desktop, the User List window is updated if you typed a new 
name. It now includes the custodian icon and name and a use r icon 
named "<Any User>." (You'll learn more about "<Any User>" 
later.) 

Checking the clock and RAM Cache 
Before making the se rver available on the network, you need to 

check that the se rver's Macintosh Plus clock is set to the correct date 
and time. You 'll use the Alarm Clock desk accessory to check the 
date and time and change it, if necessary. 

You must also check the RAM Cache. Then when you start up the 
server, frequently used information wi ll be stored in the RAM 
Cache, and the server won't have to take time to get it from the 
volume. This can improve the server's performance. But set the 
RAM Cache only at the recommended amount. 
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Using the Alarm Clock 

l. Choose Alarm Clock from the Apple menu. 

Click the "lever" on the right side of the clock. If the date 
displayed is inco rrect, click the digits you want to change. Then 
click the up arrow to advance the numbers, or click the down 
arrow to go backward. 

To change the time , click the time icon in the bottom panel on 
the left, and change the digits as you did for the date. Click in the 
top pane l to set the time. For more information, see Macintosh 
Plus, your owner's guide. 

2. Close the Alarm Clock. 

Either choose Close from the File menu, or click its close box. 

•:• Note: If you ever noti ce when you start up the server that the 
clock is los ing time, check the battery in your Macintosh Plus. 
See Macintosh Plus, your owner's guide, for instru ctions. 

Next, you'll check the RAM Cache setting, and change it and turn it 
o n, if necessary. 

Using the RAM Cache 

l. Choose Control Panel from the Apple menu. 

2. Select the On button for the RAM Cache if it 's not selected. 

3. Use the arrows to scroll the amount of memory to "64K." 

The recommended amount of me mory you can use for the RAM 
Cache is 64K. This amount may change in later ve rsions of 
AppleShare, so check with your authorized Apple dealer for 
more information . 
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Making the file server available 
You've finished preparing the server. Now you're ready to quit 
AppleShare Admin and make the server available to users on the 
network. 

1. Choose Quit from the File menu. 

You return to the Finder. 

Warning Don't move or rename any documents or folders on server 
volumes at this time. If you do, you'll have to run AppleShare 
Admin again. Such changes should only be made either with 
AppleShare Admin or over the network. 

2. Use the Chooser desk accessory to check that the AppleTalk 
Active option is selected. 

Choose Chooser from the Apple menu, and click AppleTalk 
Active if it's not already selected. Then close the Chooser by 
choosing Close from the File menu or clicking its close box. 

3. Choose Shut Down from the Special menu. 

The AppleShare Server Installer disk is ejected, and the 
Macintosh Plus starts up as a file server. 

Be patient-this can take several minutes. After AppleShare checks 
the volumes on the server and registers the server name on the 
AppleTalk network so that it can appear on users' work stations, the 
AppleShare server status window is displayed. 

Important Store the App/eShare Server Installer disk in a safe place. Don't 
copy it to a server volume. Don't give it to anyone else. 
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The server status window 

s file 

Server name ----------- Server NBme: Volumes: 
Sales & Marketing lnternBtional Sa les 

List of server volumes -------+-l-----------------1 American Sales 

List of current users, whose ----tr"~-----;;::'"";:==;:;:---;; 
names appear when they log Users: 
on 

Current date and time ------lJ2=~=;;;;;;;;;;;;;;;;:::::;:::::;:::::;':::7~ 

Wed, Sep 17, 1986 30353 PM 

Acllv1ty 
I I I I I I I I 

busy 

Activity meter ----------t:!':==================::::rn1::::rn1::::rn1::::rn1::m!!::m!!::m!!!l!m!::!.d 

In Chapter 3 you'll learn how to 
use the information in the server 
status window to monitor 
server activity. 

The AppleShare server status window tells you the current status of 
the server. In the Volumes list are all of the active volumes on the 
server. Because you've just started up the server, no users are shown 
as currently using the server. 

The activity meter tells you how much the server is being used at any 
moment. The activity level should now read "idle." 

Now that the server is available on the AppleTalk network for storing 
and sharing information, you need to help users get their work 
stations ready so they can begin using the server. 
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Getting users ready 
Before they can access the server from their work stations, users 
must install AppleShare software on their work station startup disks. 
You, too, have to update your work station startup disks. 

The AppleShare Work Station Installer disk contains the 
AppleShare software and new versions of the system files. The 
AppleShare User's Guide has complete instructions for creating or 
updating work station startup disks. 

You can either let users have a copy of the AppleShare Work Station 
Installer disk to create or update their own startup disks, or you can 
create startup disks for them. 

Make sure that all users have updated their startup disks with these 
(or later) versions of system software: Finder 5.4, System file 3.3, 
Chooser 3.0, and LaserWriter 3.1. To find out what versions are on 
a startup disk, you can: 

o Check the Finder version by starting up a work station with the 
disk and choosing About the Finder from the Apple menu. 

o Check the System file version by selecting the System icon in the 
System Folder and choosing Get Info from the File menu. The 
System file must have a creation date of January 1, 1986, or later. 

o Check the Chooser version by choosing Chooser from the Apple 
menu and noting the version number in the lower-right corner. 

o Check the LaserWriter software version by se lecting the 
LaserWriter icon in the System Folder and choosing Get Info 
from the File menu. 

•:• Note: You only need LaserWriter software if you're going to 
print with the LaserWriter. 

Every so often, check with your authorized Apple dealer to make 
sure that you have the most current software versions. 

After users have updated to AppleShare startup disks, they can 
access the server and use it for sto ring and sharing information, as 
described in Chapter 1 of the AppleShare User's Guide. 

20 Chapter l: Getting Started 



What next? 
As administrator, you may have to answer users' ques tions about 
access ing and using the file server. Read and become familiar with 
the AppleShare User's Guide. The best way to be prepa red fo r 
questions is to have hands-on experience as a user. Use the serve r 
from a work station to know how it works. One thing you might try 
right now is to create a document that contains a message that all 
users can read. 

Now that the server is running, users can log on to the server to 
create folders and store documents on server volumes. Because 
users are not registered, they will log on as guests, and anything a 
user stores on the server can be seen, changed, and delete d by any 
other use r. If you want to make it possible for users to set access 
privileges for their folders to control who has access to their 
information, go on to Chapte r 2, "Privacy on the File Serve r. " 

Otherwise, turn to Chapter 3 and read about how the administrator 
can keep the file server running smoothly. You'll also find 
information about keeping backup copies of what's s tored on the 
server. 

If for any reason you want to shut the server down and late r restart it, 
see the instructions in "Starting Up or Shutting Down the Serve r," in 
Chapter 4. 

What next? 21 



Chapter 2 

Privacy on the File Server 
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Tow that users on the AppleTalk network can access the server to 
store and share in fo rmation, in this chapter you 'II lea rn how to 
make it possible for them to control access to the ir information. 
Use rs wi ll be able to keep the contents of their fo lde rs private, or 
share them with a work group, or even make them available to all 
users who have access to the server. They can do this when they 
access the server as registe red users and set access privileges fo r the 
folders they create. 

After you learn how to registe r users so they can set access privileges 
for the ir folders, you 'll lea rn about setting up groups on the server 
that re fl ect the work groups in your office. Then members of a group 
will be able to share informatio n among themselves on the serve r 
without letting others see or use it. 

Planning ahead 
You'll begin by gathering, from the users on yo ur network, the 
information you need in order to register them and set up groups. 
To keep the file server avail able fo r use rs as much as possible, it's 
best to plan carefully when you'll shut down the server and use 
AppleShare Admin to registe r use rs and set up g roups. 

First, you need to make a list of all the people who will be using the 
server. In consu ltation with each user, w rite down the name and 
password each user would like to use to log on to the server. 

However, before you do this, you may want to decide how you 'll 
ente r their names on the server. Because user names are 
alphabetized in the User List window, it's a good idea to enter the m 
in a consistent way-first names only or last names first, for 
example-so it'll be easy for you to find them when you're using 
AppleShare Admin. 
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You' ll learn what it m eans to 
speci fy a user's primary group 
later in this chapter . 

If you w ant . you c an register 
users now and create groups at 
another time. 

Here are some guidelines fo r helpi ng a user to choose a name and 
password: 

o let the user know how you plan to enter user names so the user 
can choose a name accordingly. 

o A user name can be up to 31 characte rs long. 

o No user can have the same name as anothe r user. 

o A password can be up to e ight characte rs long. Make sure you 
note which characte rs a re uppercase and lowercase. 

o A user should not choose a password that can be easily guessed
a nickname , fo r example-and should not te ll othe rs the 
password. That way, no one else ca n use the password to log on 
to the serve r and have access to that use r's fo lders. 

Next, you can note the user's department and lis t any projects the 
user is working on. La te r, you can compa re your notes on each user 
to get an idea of which users belong to the same work groups. \'(!hen 
a user is a member of several groups, note which group the user 
works with most of the time. Usually, this group is the use r's 
primary group-the group of users with whom the user will most 
often be shari ng documents stored o n the serve r. 

You can also ask groups in your o rganizatio n, such as departments 
or project teams, to give you lists of users in their groups and suggest 
what names they'd like the ir groups to have on the se rver. 

Here are some guidelines fo r choosing a grou p name: 

o A group name ca n be up to 31 characte rs long. 

o No group can have the same name as anothe r g roup. 

When you have a p reliminary list o f grou ps and the ir members, 
confirm w ith users that you 've listed them in the correct groups. 
Because it may take longer for people to agree on what groups they 
want to be in and what they want them to be caJled, you may wa nt to 
registe r users first and the n se t up groups at another time . 
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Shutting down the server 

Any time you need to use AppleShare Admin to make changes to the 
server-as you'll soon do when you register users-you must shut 
down the se rver. When you begin Lhe shutdown procedure, you'll 
decide what time you want the server to shut down, and the server 
will notify use rs at all work stations about the coming shutdown. 

Warning Never switc h off the Macintosh Plus o r any hard disk that's part 
of the server without first going through the shutdown 
p rocedure, or else information that has not been saved to a 
volume or work station disk may be lost. 

Choose a time to shut down the server when server activity is 
relatively light. Avoid shuLLing down the server wh ile a use r is 
logged on and printing a long docu ment from a work sta Li on. 

l. Choose Quit from the File menu. 

A dialog box appears and asks you to specify Lhe number of 
minutes until shutdown. Because te n minutes is usua lly enough 
time for users to finish work and log off, the dialog box already 
shows "10." But try to a llow e nough time for users who may be 
away from their work stations to reLurn , save Lhe ir work, and log 
off the server. 

Number of minutes 

until shutdown? 

The number you type -------"""*-----IU•MI 
replaces the selected number 

~~=1 ([ Cancel J) 
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2. Enter the number of minutes until shutdown . 

Either leave "10" or type a number from 0 to 4094 (about 68 
hours). You can type whole numbers only-not fractions. 

Caution If you type "O" as the number of minutes until shutdown and 
then click OK. the server wi ll shut down immedia tely, wi thout 
notifying users so they can save their work. 

You can cancel the countdown 
at any time by clicking Cancel. 
The server will notify logged-on 
users at their work stations that 
the shutdown has been 
cancelled. 

3. Click OK. 

A dialog box shows the minutes and seconds remaining until 
shutdown. 

Time left until shutdown: 

9:5 7 

([ Cancel JJ 

After you click OK, the server sends a message to all work stations 
that are logged on at that time. The message tells users how much 
time remains before shutdown. 

If you entered a countdown time of more than 60 minutes, Lhe 
server sends additional warning messages over the network every 
hour. During the final hour, messages are sent every ten minutes, 
then at five minutes, two minutes, and one minute before 
shutdown. During those last five minutes, use rs can't log on to 
the server. 

When the countdown finishes, a message tells you that the server 
has been shut down. If anyone on the network is still using the 
server, information that has not been saved may be lost. (See the 
AppleShare User's Guide for further de tails about what happe ns at 
a work station during the shutdown procedure .) 
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Warning After the server has been shut down, do not add , delete , or 
otherwise make c hanges to server volumes, except by using 
AppleShare Admin . If you do , you ' ll have to use AppleShare 
Admin aga in to make sure the se rver has correc t info rma tion 
about each fi le and folder on the server. 

Now that the se rver is shut down, you 'll restart the Macintosh Plus 
w ith the AppleShare Server Installer disk so you ca n begin 
registe ring users. 

•:• Keep in mind: You can take a break fro m this chapte r at any 
point. Leave everything switched on and p ick up where you left 
o ff. But re me mbe r, afte r you've ope ned AppleS hare Admin , 
you must make sure that no o ne e lse uses it to access or change 
informatio n on the serve r. If you have the se rver in a secure 
p lace , you do n 't have to worry ab ou t its conte nts be ing 
tampe red w ith . 

If you need to make the server available aga in before you finish 
this chapte r, re fe r to "Ma king the File Serve r Ava ilable" in 
Chapte r 1 fo r instructions. At another time, you can shut down 
the se rve r and continu e with this chapte r. 

Registering users 
Afte r you ope n AppleShare Admin, you 'll registe r each user by 
e nte ring the user's name and password in a user information 
window-in the same way you e nte red the custodian's name and 
password in Chapte r 1. So have your list of users and the ir 
passwords nea rby. 

1. Insert the App/eShare Server Installer disk in the built-in disk 
drive, and click Restart. 

You're soon in the Finde r, w ith the Serve r Insta ll e r d isk icon on 
the desktop. 
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2. Open the Server Installer disk icon , if it 's not already open , 
and then open the AppleShare Admin icon. 

To open an icon, select it and choose Open from the File menu, 
or just double-click the icon. 

After AppleShare Admin checks for server volumes, you're asked 
to enter your Admin key so you can use AppleShare Admin to 
work with the server. 

3. Type the Admin key. 

As you type, each character appears as a large dot. 

Sale\ I}' Marketing 

The Admin key you type -------++------------"'----~ 
appears as large dots Enter Ad mm Key: ~··•••I J 

{3i~J I Finder I 

Remember to type the Admin key exactly as you first typed it 
when you were getting the server ready. Be sure that you type 
uppercase and lowercase characters in the same way. If you 
origina lly entered "sesame," then typing "Sesame" wi ll not open 
A ppleShare Admin. 

If you typed the Admin key incorrectly and then clicked OK, 
you're asked to try again. You have two more tries before you 
automatically return to the Finder. 

If you've forgotten both the Admin key and where you wrote it 
down, refer to Chapter 6, "Troubleshooting." 

4. Click OK. 

AppleShare Admin completes its check of server volumes and 
then displays the User List window and the Group List window. 
The User List window contains two names : "<Any User>" and the 
custodian name. The Group List window is empty because you 
haven't yet crea ted any groups. 
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Remember. make sure that the 
Log in Enabled option is selected 
(an ·x· is in the check box) if 
you want this user to be able to 
log on to the server. 

You can now register users one at a time on the server. The steps 
that follow show you how to register a user. Then you can follow the 
same steps to register the other users. 

5. Choose Create User from the Users menu. 

A new user information window titled "New User" appears. 

6. Type the user's name. Don 't press Return . 

The name can be up to 31 characters long. 

If you happen to type a name that's already being used, you'll be 
asked to choose another name. You can't make two names 
different just by capitalizing one and not the other. For example, 
the server considers "Bruce" and "bruce" to be the same use r 
name. 

7. Press Tab, and type the user's password. 

A password can be up to eight characters long. As you type, each 
character appears as a large dot. 

If you think you've made a typing mistake, select the dots and 
re type the password. 

8. Click OK. 

AppleShare Admin saves both the user name and password on 
the server and lists the name alphabetically in the User List 
window. Also, the title of the use r information window now 
includes the user name. 

For now, don't worry about the places in the user information 
window for entering a primary group and other groups. 

30 Chapter 2: Privacy on the File Server 



User information w ind 

User name you typed 

User icon and name ad 
the list of registered u 

User password you typ 
appears as larg e dots 

ow 

dedto 
sers 

ed 

When selected. the u 
named in the window 
on to the server 

ser 
can log 

" File Edit Users Groups Senoet Uolumes Folders 

l User list '-.:: 0 User: Brue e 
.. 1~.,.r N.::imi:-

D " D Any User 
Name:'flBru ce l " [j Alar·· 

1'0 Pmw0<dJ ••n }c0 Logio Eoobl•d Bru ce 

I "' ~-l I 1"""-'' 1 I 
Primary Group: [ Z l 

Group List Groups: 

I I I 
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I--

9. Close the user information window by clicking its close box. 

l 0. Register the other users. 

Repeat steps 5 through 9 until all use rs are liste d in the User List 
w indow. 

You may also want to registe r yourself with a user name and 
password if you're going to be accessing the server for your own 
personal work. That way, you can log on to the server as a user. 

•!• Note: After you click OK in step 8, you can leave the use r 
information window displayed and late r close all of the user 
information windows at o ne time by choosing Close All from 
the File menu. If you do this , all o f the displayed w indows 
close-including the User List and Group List w indows. Before 
go ing on, display the User List and Group List w indows aga in by 
choosing User List from the Use rs menu and Group List from the 
Groups me nu . 

If you 're not going to se t up groups right now, it's important for you 
to continue in this chapter with "Backing Up Users and Groups 
Lists." 

If you're going to set up groups, go on to the next secti on. 
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Setting up groups 
By setting up groups of registered users on the server, you make it 
possible for users to limit access to the information in the ir folders 
to just the members of a group. 

It works like this: AppleShare lets a user assign one group to any 
folder that the user owns. Then the user can set access privileges for 
that folder so the members of the group have access to what's in the 
folder. In this way, a user can assign a group to a folder so that a 
group of coworkers can use the contents of the folder while other 
users can't. (Later in this chapter, you'll learn how you can use 
AppleShare Admin to assign a group to a folder and set access 
privileges.) 

As administrator, you'll set up groups according to the needs o f 
your organization. For example , managers or project teams may 
want you to setup groups of users with whom they can share 
information while keeping it private from othe r users o n the 
network. 

Before you create groups and name them, make sure you have a list 
of groups and the users who will be members. If you don't have a 
list, see "Planning Ahead" earlier in this chapter for ideas about 
how to collect information for the list. 

With your list of groups in hand, you'll learn how to create groups, 
name them, and assign users as me mbers. You'll also learn how to 

specify a primary group for a user. That way, when Lhe user creates a 
folder, the primary group is automatically ente red as the g roup o f 
users to which the user may want to give access privileges fo r that 
folder. 
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Creating a group 
You'll s tart by creating a g roup, naming it, and assigning users to it. 
The n you can follow the same steps to se t up additional groups on 
the server. 

1. Choose Create Group from the Groups menu. 

A new group information window titled "New Group" appea rs. 

2. Type the group's name. 

The name can be up to 31 ch aracte rs long. 

If you happen to type a name that's already being used, you 'll be 
asked to choose another name. 

3. Click OK. 

AppleShare Admin saves the g roup name and alphabetical ly li sts 
it in the Group List window. Also, the title bar of Lhe group 
informatio n w indow now includes the group name . 

• file Edit Us en Groups Se mer Llolumes folders 

User List " D Group: Product Management 
U::"'r N:tff• 

D cl lf f 11ll ' Name: If rodu ct M anagement 
D Gere I 

D ~0~1n 
I I h~t' l D r"Jancy -~-

I 
--

D Patn f M•mbml 
! I 

D F'1ct·1 

Group List 
(if•)IJ~· n::imt? 

ill Product Managem ... 

H 

Next, you 'll assign users to this group. 
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Registered users who are not in 
any group will have access only 
to their own folders . or to those 
folders to which all users on the 
network have access. 

Assigning users to the group 

As administrato r, you're the o nly person who can ass ign users to a 
group (or remove them). You can assign each use r to one or more 
groups (up to 15 groups), or to none at all. Whenever you assign 
users to a group, it 's you r responsibili ty to te ll use rs which groups 
you've assigned them to and who e lse is in those groups. 

AppleShare Admin provides more than one way to ass ign users to a 
group. This section describes just one of the m. You' ll ass ign use rs 
to the group you just created by dragging a user's icon (and name) 
from the User List window to the Members list in the group's 
info rmation window. (See "Adding a Use r to a Group" in Chapter 4 
for othe r ways to assign users to groups.) 

l. In the User List window, select the name of the user you 
want to assign to this group. 

You can se lect a name by clicking the name o r its icon. 

You can also select mo re than one name by dragging through the 
list of names (not the user icons) , or by Shift-cl icki ng to select 
names anywhe re in Lhe list. 

Scroll the list, if necessary, to find all the names you want. 

If you change your mind about a se lectio n, you ca n deselect a 
name by Shift-clicking the selection. 

2. Drag the selected user icon from the User List window into 
the Members list of the group information window. 

Position the pointe r on a se lecte d user icon to drag the icon and 
its name. As you drag, a doued outline of the selected icon and 
name appears. Drag it into the Members list in the group 
informatio n window until the rectangle is highlighted, and then 
re lease the mouse button. 

If you've selected more than one name, drag any selected icon 
and all the selected icons and names move in formation. 
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s File £dit Users Groups Senoer llolumes Folders 

Group: Product Management 

Name : I Product Management 

The selected users will be ------"" 
added as members of the 
group 

Group List 

QJ Publ1cat1ons 

As soon as you release the mouse button, the window is updated 
to include the newly added users as members, and the changes 
are automatically saved on the server. 

•:• Note: You can assign users to groups only by dragging icons to 
the appropriate places. You can't assign members by typing 
their names in windows. 

3. Close the group information window by clicking its close box. 

To see that a given user has been added to a given group, you can 
also select that user's name in the User List window and choose 
User Info from the Users menu. Look in the Groups list in the 
user's information window for the names of that user's groups. 

4. Create the other groups and assign users to them. 

Repeat the steps in "Creating a Group" and in this section. When 
you've finished setting up groups, read on to find out about how 
you specify a group to be a user's primary group. 
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Only the administrator. using 
AppleShore Admin. con change a 
user's primary group. 

Specifying a user's primary group 
If most of a user's work stored on the server is related to one 
parti cular group , you can specify that group as the user's primary 
group . 

Just as a folder on the server has an owner, it also may have a group 
associated with it. In particu lar, if you specify a primary group fo r a 
user and that user creates a folder, the user's p rimary group is 
automatica ll y listed as the group to w hich the user may give access 
privileges fo r that folde r. 

Entering a primary group is fo r the user's conven ie nce, so make 
sure you 've first discussed this with the user. If you have a list of 
registe red users who want you to specify a p rima ry group for them, 
follow these steps to specify a primary group fo r each use r. 

1. Select the user's name in the User List window. 

2. Choose User Info from the Users menu. 

The user's information window is displayed. 

3. In the Groups list in the user's information window, select the 
group that will be the user's primary group, and drag it into 
the place for the primary group. 
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s File Edit Users Groups Seruer Uolumes Folders 

User Lrs t ~O User: Scott 

D Nar1Cld 
D p,,tri u 
D F"ct·, 

D C:,cot• 
D c;,1d1-,u 

D Name: I Scott 
!========~~~~~~_____J 

Password: I •uoo ~ Logrn Enabled 

Primary Group: 
The selected group will -------t=======t-----:------. ,-,,jli!=========::=; 
become the primary group Group Lrst Groups. 

CD EasterT1 Peg1on 
Research & Developm 

CD Pro duet ~lanage.__....-..-------~--------.J 
CD Putol1cat'Ons 
CD Research & Devel 
CD \~'estern Peg1on 

The group icon and name appears in the p lace for the primary 
group, and the group is now the user's primary group. Notice that 
the primary group is still listed in the Groups list in the user 
information window. 

4. Close the user information window by clicking its close box, 
and repeat the above steps for other users. 

After you've finished specifying primary groups for users, it's time 
to save the users and groups you've listed on the server. 
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Backing up users and groups lists 
Afte r doing all that work to registe r users and create groups, it's 
important to make a backup copy of AppleShare's lists of users and 
g roups. 

Important If you forget your Admin key or if anything happens to make 
AppleShare 's lists or the startup volume unusable (even though 
it's unlikely) , you can use the backup copy when installing 
AppleShare on the server again . 

For convenience and safekeeping, it 's a good idea to back up the 
The users and groups lists are in a lists to the AppleShare Server Installer disk on which AppleShare 
file called Users & Groups. Admin is stored. (You can choose to save them o n any o the r d isk.) 

l. Choose Save Users & Groups As from the File menu. 

A dialog box appea rs that lets you save the fil e. 

2. Click Volume until you see the disk Server Installer. 

Directory na rne -------------1~ Seruer Installer I 

D System Folder 
Eject Disk where file wi ll be saved ------1+--+---------+--r 

Llolume 

S<rne Users G Groups as: f[ Saue ~] 
What you type replaces the ----~f--1 
selected name ~========= 

SaL•ed Users G Groups [ Cancel J 

If you want to save the file in a fo lder, you can open fo lde rs in the 
list by double-clicking them un ti l you open the folde r whe re you 
wa nt to save the fil e. 

If you want to save the file on a di ffe re nt d isk, cl ick the Eject 
bu tton and insert the othe r disk. 
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Users at work stations create 
folders on server volumes as 
they always c reate fold ers -in 
any Finder w indow. 

3. If you want to use "Saved Users & Groups" as the name of 
the copy you 'll save, go on to step 5. 

4. Type a name for the file. 

The name can be up to 31 characters long. You can use any 
character except a colon (:) . 

5. Click Save. 

The file is saved with the name you chose. 

The next time you use AppleShare Admin to make changes to the 
lists of users and groups on the server, be su re to save a backup copy 
of the lists just as you did here. 

Now you're ready to learn how to use AppleShare Admin to create 
folders on the server and set access privileges for them. 

Setting up folders with access privileges 
Now that you've created a list of registered users, any registered user 
who creates a folder on the server is the folder's owner. The folder is 
automatically set up as a private folder. Only that user can have 
access to the information contained in the folder unless the user 
gives access privileges to others--either to the users in a group or to 
all users on the network. If you specified a primary group for that 
user, the primary group is automatically entered as the group 
associated with the folder. (See the AppleShare User's Guide for 
more information about how users at work stations can create 
folders and set access privileges.) 

While you can create folders from a work station (and keep the 
server available on the network), you can also use AppleShare 
Admin to create a folder, set access privileges, and even assign a 
registered user as the owner. You may want to create folders for a 
new user at the same time that you register the user. 
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With AppleShare Admin, you can also see and change the access 
privileges of every folde r on the se rver-including fo lders you don't 
own. However, it's always a good idea to check with a folder's owner 
before changing the access privileges. 

After you create a folder and set access privileges for it, you'll have 
firsthand experience about how the server can protect the privacy o f 
the information that users store in a folder. 

Warning When the server is shut down, do not create folders or files from 
the Finder of the server's Macintosh Plus. In addition , while 
using AppleShare Admin, do not make changes to a server 
volume with a desk accessory. The server will have no 
information about the access privileges for these folders end 
files , and you cannot make the server available on the network 
until you use the Verify Access Privileges command in the 
Volumes menu of AppleShare Admin. See Chapter 5, 
"Reference: for a complete description of this command. 

Using AppleShare Admin to create a folder 
When you use AppleShare Admin to create a folder on the serve r, 
you can create the folder anywhere on the server- on any volume 
and in any folder. For now, you'll create a folder in a volume 
directory. 

Before you begin, make sure t.11.e User List window is displayed. 
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1. Choose File & Folder Info from the Folders menu. 

A dia log box appears, with a list of the fo lders and docume nts in 
a server volume directory. (If this is a new volume, all the 
d irectory contains is the Server Folder.) 

Select a file or folder to L•iew information: 

Volume d irectory where the -----1-----1 = Ameri can Sales 
new folder w il l be created 

Folder information win dow 

Where you type the fo 
name 

Where you set access 
privileges (later in this 
chapter) 

Ider' s 

Where you assign a use 
the folder's owner 

r as 

Where you assign a gro up to 
the folder 

CJ Seruer Folder 1J 
([ &et Info JJ ,=American ... 

~--~] !_,.1 

Cancel L__ 
[New Fold~ 

[ l 
Uolume 

2. Click Volume if you want to go to the volume directory of 
another volume. 

3. Click New Folder. 

A new folder information window title d "New Folder" appears . 

• File Edit Users Groups Seruer Uolumes Folders 

User List ' :O New Folder 
JsPr N~mP 

CJ 0 Any User· 
Name:[ J [j Alar., 

0 Bn .. ce Short Name· 

0 : arr 1 e .--See Folders: ~ owner D Group D Eueryone 
0 = 11 ff See Files : ~ Owner D Group D Eueryone 
0 r3ene Make Changes: ~Owner D Group D Eueryone 

D Change All Enclosed Folders 
Group List I I [ fj(~~~~.l:l 1 I 
G, n •r "' ~ 

rn Ea t~rr PAq Owner°?'[ J 
[Il Pr[ 1j1.J l I 'a aq 

_ _[JJ_ P11t-1]1 j 111n -
Group· J 

rn Rese H. 11 " Contents: 

rn ~cterri P 1 Created: 
Modified: 
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Every folder you c reate with 
AppleShare Admin must be 
assigned an owner. 

4. Type a name for the folder. 

Perhaps use the name "AppleShare Reports." Then you can use 
this folder in Chapte r 3 to sto re AppleShare reports. You'll be 
using AppleShare Adm in to create reports about user acLivity on 
the se rve r. 

A fo lder name can be up to 31 characte rs long. You ca n use any 
characte r except a colon (:). 

5. Assign yourself as owner of the folder. 

Drag your custodian icon (or user icon if you also have a user 
name) from the User List w indow into the p lace fo r the owne r 
name in the folde r info rmatio n window. Whe n the recta ngle is 
highlighted, re lease Lhe mouse button. 

s File Edit Users Groups Seruer Uolumes Folders 

D User List 

Group List 
Gro1Jp Name 

Cl] Eastern Region 
Cl] Product Manage 
Cl] Publ1cat1ons 
Cl] Pesearct1 & De·,1 
Cl] w'estern Region 

New Folder 

Name: I RppleShare Reports 

Owner: 

Group:'--~~~~~~~~~~~~ 

Contents: 
Created: 

Modified: 
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The ow ner does not need to be a 
memb er o f the group assigned 
to the folder. 

See ·Assigning a Group to a 
Folder or Volume" in Chapter 4 
for other ways to assign a group 
to a folder . 

Your icon and name appear in the place for the owner, so you 
are now the owner of this folder. Like any other user, if you access 
the folder from a work station, you can change any of the 
information that you find in the folder information window. You 
can even make another user the owner. 

If you didn't create groups on the server, skip the next step . 

6. Assign a group to the folder, if you wish. 

You can assign any group in the Group List window to this folde r, 
or leave the folder without a group. 

You can also create a group, assign it members, and the n assign 
it to the folder. For example, if you're going to use this folder to 
store AppleShare reports about the server, you might want to 
create a group of supervisors who can use the reports to see how 
users in their departments are working with the server. You can 
then assign this group to this folder. That way, you can give the 
supervisors access to the folder-if you give access privileges to 
that group. 

To assign a group to the folder, drag the group icon from the 
Group List window into the place for the group name in the fo lder 
information window. When the rectangle is highlighted, re lease 
the mouse button. The group icon and name appear in the place 
for the group name, and that group is now the group to which you 
can assign access privileges for the folder. 

7. Make the folder information window active, and click OK. 

Click anywhere in the window to make it active before you click 
OK. 

The folder is created on the server, and the information you 
entered is saved. 
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The number of fil es and 
folders in this folder and 
space they use on the 
volume 

the 

The date and time the f 
was created and last 
modified 

older 

• File Edit Us en Groups Senoer Llolumes Folders 

User List D Folder: AppleShare Reports 
IJ~E-r N ~rno? 

D Anq ,Jser· LJ Name: llAppleShare Reports ~ [i H 1 t1r1 

[) Eir JI.~ Short Name: !AppleSh.are 
D C.:n1~ See Folders: [2] Owner D Group D EL•eryone 
D c 'i ( See Files: [2] Owner D Group D EL•eryone 
D 1~ere Make ( hanges: [2] Owner L Group D EL•eryone 

I" 
···' D Change All Enclosed Folders 

Group List I I 
(•roup ri~1 ,.,. ~ ~~ 

m E,Lten, F·eJI in Owner: I [i Alan I m F'r d14 t r.-1 :ir :,qe 
Group. [ 

-~ 

m F'ut1l11 M·or · 1 

m Pe·0,E or _I _ e' Content s: o K, o file s, O folders 

m F~•enFJ. Created: Thu , Sep 18, 1 986 at 1 O:SS AM 
Modified: Thu , Sep 18 , 1986 at 1 O:SS AM 

Notice that some additional information is automatica lly added 
to the w indow. The name in the title bar reflects the name you 
gave the folder. 

In the bottom panel you see the number of files and folders 
inside this folder ("zero" because you just created the folder) and 
how much space those files occupy on the volume (also "zero"). 

You can see the date and time you created the folder and the last 
time anything about it was changed-either while you're using 
AppleShare Admin or while the server is running. (The date and 
time for "Created" and "Modified" are the same until additional 
changes are made .) 
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Next, you'll learn how you can use folders and access privileges to 
organize and protect what you or oLher users store on the server. 
And you'll establish access privileges for the new folder you just 
created. 

For now, don't close the information window of the folder you just 
created. You'll soon be working with it again. 

But take your time when you read the following section that explains 
access privileges. Understanding access privileges and using them 
properly gives you (and users) great flexibility about how 
information is shared or kept private. 

Using access privileges 

The way manila folders (and their paper documents) are organized 
in an office, and shared or kept private, can be reflected in the way 
electronic folders and documents are stored on the server, and 
shared or kept private, depending on what access privileges the 
folders' owners assign to other users on the network. 

When you first create a new folder on Lhe server, the folder is 
automatically set up to be a private folder. From a work station, only 
the folder's owner can use what's in it. 

For example, when you're at a work station, you may want to store 
some documents in the folder you just created and keep them 
private. Or you may decide that you want to share the 
documents-for example, share AppleShare reports that you want a 
certain group of supervisors to have access to. Or you may want 
every user with access to the server to be able to use the reports to 
see such things as what groups they are members of. In addition, 
you may want the original reports to remain unchanged. 
AppleShare lets you decide. 
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At a work station. the user who 
creates a folder is usually the 
folder's owner. The folder's 
owner can assign a group to the 
fo lder-as well as assign access 
privileges to each user category . 

The word files-as it's used 
here-includes documents and 
applications. 

The AppleShare User's Guide 
contains examples of how to 
set up special folders-for 
example, a drop box and a 
bulletin board . 

When you set access privileges for a folder, you must decide what 
privileges you want to assign to each of the following three user 
categories: 

o Owner-meaning the folder's owner (whom you can assign 
from the list of users on the server) 

o Group-meaning the group of users associated with the folder 
(whom you can assign from the list of groups on the server) 

o Everyone-meaning every user with access to the server 

For a folder, you can assign each user category any combination of 
the following privileges: 

o See Folders-which is the privilege to see the other folders (if 
any) in the folder 

o See Files-which is the privilege to see documents and 
applications (if any) in the folder as well as open and copy those 
documents and applications 

o Make Changes-which is the privilege to make changes to the 
folder's contents, including moving or deleting any of its 
contents (unless a folder inside the folder has access privileges 
that don't permit you to make changes to it) 

For example, if you assign a group to the folder you created and 
assign the See Files privilege to the Group category (but no t to the 
Everyone category), only a user who is a member of the folder's 
group can open a document you might store in that folder. After the 
document is opened, the user sees a copy of the document that's in 
the Macintosh's memory (the original is still on the server). The 
user can edit and print this copy and save it to another folder to 
which the user has adequate access privileges. However, without the 
Make Changes privilege, the copy cannot replace the original in 
your folder or be saved in your folder; the user cannot make 
changes to your folder or its contents. 

Note that when you assign the privilege Make Changes, you do not 
automatically assign the privileges See Folders and See Files. This 
way, you can mix and match privileges to create folders for special 
uses. 
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And by nesting folders inside of each other and assigning different 
privileges to each folder, you can organize information on the 
server to reflect how information is shared or kept private in your 
office. The following section is an example of how to take advantage 
of these features. 

A closer look at access privileges 

When you have folders within folders, you can establish separate 
access privileges at every level of folders. 

You could create a group named Marketing, whose members are the 
employees in the Marketing Department of your company. You 
could also create a group for each project team within the Marketing 
Department. 

Cl George ]-- CD Eastern Region 
Cl Sidhu 

Cl Cl iff 

}CD CD Marketing Cl Mol l y Pub l ications 

Cl Scott 

Cl Bruce }- CD Western Region 
Cl Linda 

A ll users in the Marketing Department are in the Marketing 
group and in one project group. 

To keep all marketing information that relates to current projects in 
one place, create a folder named "Current Projects,'' assign the 
marketing manager as the owner, and assign the Marketing group to 
the folder. Then assign the See Folders privilege to the Group 
category. Any user in the Marketing group will be able to see what 
folders are inside the Currents Projects folder, but not make 
cha nges. 

Next, create folders within the Current Projects folde r. Name each 
folder after a project group, assign each team leader as the 
respective owner, and assign each project group to its 
corresponding folder. Then assign the See Folders, See Files, and 
Make Changes privileges to the Group category. Members of the 
project groups can make changes to their project folder by adding 
their own folders. 
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Group : 

Access pr-ivileges 

Group 

Access privileges : 

Q] Morketing 1---~ 
See Folders i:.=-.J 

Current Projects 

CJ 
Eastert Region 

Q] Eastern Region Q] Publications 

See Folders See Foldet'"s 
See Files See Files 

Make Changes Make Changes 

Q] Western Region 

See Foldet'"s 
See Files 

Make Changes 

Project folders for different groups are within the 
Current Projects folder. 

Later, the marketing manager-who is owner of the Current Projects 
folder-can easily create a new project group folder whenever a new 
project begins (but only you, as the administrator, can create a new 
group). The manager can even add other folders that have different 
access privileges-for example, a Memo folder for all the 
department memos so everyone can look at them. 

AppleShare gives you great flexibility in organizing information . 
Experiment until you find the best arrangement for your office. 

Setting access privileges 

Now that you have a better idea about what access privileges mean 
and how you can use them, you'll set access privileges for the folder 
you created. 

Notice that the Owner category has all three access privileges 
assigned. You can tell this by the "X" in each Owner check box. For 
now, keep all your access privileges as Owner. 

If you plan to keep this folder as a private folder and not le t other 
users have access to it, you can skip to step 3. l3ut you might want to 
try selecting and deselecting privileges just to see how it's done. 
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An ·x· appea~foreach 
selected option 

l. If you assigned a group to the folder and want to assign 
access privileges to that group, select the appropriate 
access privileges for the Group category. 

Click Group for each access privilege you want the folder's group 
to have. If you change your mind, click the option again to 
deselect it. 

Setting access privileges for the Group category has no effect 
unless a group has been assigned to the folder. 

2. Select the appropriate access privileges for the Everyone 
category . 

" File Edit Users Groups Seruer Llolumes Folders 

User List ~D Folder: AppleShare Reports 
U~e-t N,me-

D 
j 

LJ 1-111 1 User Name: llAppleShare Reports 
[i Ala11 

l'l E1 -,JI I: Short Name: ! AppleSh.are 

u rltTle See Folders: 0 Owner D Grou 0 Eueryone 
D [I 11 i See Files : 0 Owner D Group Eueryone 
D Ger Make Changes: 0 Owner D Group Eueryone 

D Change All Enclosed Folders 

Group List (l i) 1-- OK I Reuert I 
(•t'O"~ fj" • 

m East.er·n Pe1~1or. Owner: I [i Alan 

I 

I m FT01jL,1. t 11.•irrnge Group: l J m F'utl1:at1u: 

m Re: earc 1·, uev ( ontents: o K. o files, O folders 

m V./e~ ter-11 F:·e1~1 nr1 ( reated: Thu, Sep 18, 1986 at 1 0:55 AM 
Modified: Thu, Sep 18, 1986 at 1 0:55 AM 

The Everyone category means "all users on the network" and 
includes both the folder's owner and group. So any privileges 
given to Everyone are automatically given to the owner and 
group as well. 

3. Click OK to save the settings. 

The information that you entered is saved on the server. 
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Remember. if you make changes 
to a server volume with a desk 
accessory while you're using 
AppleShore Adm in. you must use 
the Verify Access Privileges 
command to check that the 
inform ation about access 
privileges on that vo lume is 
correct. See "Starting or 
Quitting AppleShore Admin" in 
Chapter 4 for instructions . 

•!• By the way: The Change All Enclosed Folders optio n is useful 
only when you set access privileges for a fo lder that conta ins 
othe r folders . It allows you to assign the sa me access privileges, 
owner, and group o f this folder to all fo lders within it. You 
sho uld seldo m, if ever, need to do this . 

4. Close the folder information window by clicking its close box . 

The next time you access the se rve r from a work station, this 
fo lde r w ill be available over the network, w ith the access 
privileges you set. 

5. Create as many new folders as you want, giving each one a 
name a nd assigning an owner, a group (if desired), and the 
appropri ate access privileges. 

Follow the steps that begin in "Crea ting a Folder With 
AppleShare Admin" ea rlie r in this chapter. Or for su mmaries of 
the various procedures, see Chapter 4. 

•!• Note: You can also se t access privileges for an entire se rver 
vo lume. See Chapte r 4. 

Afte r you've finished setting up any additiona l folders, you' re ready 
to quit AppleShare Admin and resta rt the se rver. 
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Restarting the server 
After you quit AppleShare Admin and restart the server, all the users 
you registered will be able to log on to the server, set access 
privileges for the folders they create, and even assign a group to 
such folders, if they wish. If you specified a primary group for a 
user, AppleShare will automatically assign the primary group to any 
folder that the user creates. 

In addition, each folder that you created with AppleShare Admin 
will be available for those users who have access privileges to them. 
Whoever you assigned as the owner wi ll be able to change those 
access privileges . 

1. Choose Quit from the File menu. 

All windows close and you return to the Finder. 

2. Choose Shut Down from the Special menu. 

The AppleShare Seroer Installer disk is ejected, and the server 
starts up again. Soon the AppleShare server status window is on 
the server's screen. 

•:• Note: Users who are not registered can still use the server by 
logging on as guests, but they wi ll have access only to those 
folders to which all users on the network have access. Because 
guests aren't registered, they can't be the owners of folders they 
create. Instead, "<Any User>" is the owner, and anyone can 
change the folder's ownership and access privileges. See the 
AppleShare User's Guide for more information about guests 
using the server. 
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Getting questions answered 
You've learned a great deal about how information is shared or kept 
private on the server-from registering users and creating groups to 
creating folders and setting access privileges. A5 you work with the 
server as the administrator, you'll probably have questions about 
making changes to the server. How do you add and remove users or 
groups? How do you change names, passwords, or access 
privileges? How do you check access privileges for a folder or 
volume? 

When you want more information about using the server or need a 
reminder about how to do something, look in Chapter 4, "Using 
AppleShare Admin." You'll find useful summaries for doing most 
of what you need to do as the administrator of the server. 

Now that the server is set up to provide for privacy of information 
and is available on the network, you probably would like to take a 
break. When you're ready to begin again, go on to Chapter 3, 
"Keeping the File Server Running Smoothly." 
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Chapter 3 

Keeping the File Server 
Running Smoothly 
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Monitoring the flow of information 
The flow of information in an office is constant, and the AppleShare 
file server that's now connected to AppleTalk is the cente r of your 
desktop communications network. The server allows users at their 
work stations to store and share Macintosh documents, folders, and 
applications. 

As administrator, you'll need to monitor what's happe ning on the 
server to keep it running smoothly. Volumes need to have enough 
space for users to store their information. Folders and the ir 
contents need to be arranged on the serve r so users can easi ly find 
what they need. Eventually, you may need to add more volumes to 
the server or another file server to the network. 

This chapter shows you how to keep track of how the server is being 
used-and how this information can help you keep everyone o n the 
network working efficiently. You'll also learn about keeping backup 
copies of what's stored on the server. That way, you (and other 
users) can weather the accidental loss of information from a se rve r 
volume if it should happen. 

A little further in this chapter, you'll be asked to shut down the 
server so you can use AppleShare Admin. So before you begin, 
make sure this is a convenient time to shut down the server. 
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Checking server activity 
while the server is running 
\'<1hile the file se rve r is available on the ne twork , you can monitor 
some of its current activity by taking note of what's happening in the 
AppleShare serve r status window. You can also see a list of the 
messages that appeared on your server screen whe n the serve r was 
starting up. AppleShare saves them, and they can be helpful if you 
need to do any troubleshooting. 

You 'll first take a look at the server status window. Then you 'll lea rn 
how to use what you see in the status window to improve services to 
users. You'll also check to see w hat AppleShare messages are 
already stored on the server. To do this, the serve r must be 
available on the netwo rk. 

If you're running a concurrent server applica tio n on the se rve r and 
you don't see the server status window, you ca n still read this section 
and find out how to use the status window for the times when it is on 
the scree n. 
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Checking the status window 

You'll usually see the AppleShare server status window on the 
server's screen unless a concurrent server application is running on 
the server. 

• File 

Server name------------1-k. Server Nome Volumes 

List of server volumes Sales & Marketing International Sa l es 
----------------------

1 American Sales 

List of current users. whose ----H--t----~~"""'"""'~-~ 
names appear when they log 
on 

Carrie 
Petri ck 
Rich 
Sidhu 

Wed , Sep 24, 19B6 1 0 15 22 AM 

Current date and time -------l+-~========~===d' I I I I I' I' I I 

idle- busy 

Activity meter --------~t==========:::;:;;:::;:;;:::;:;;:::;:;;:::;:;;:;;;=~-------...J 

The server status window contains the server name and three 
indicators of server activity: 

o The Volumes list shows the volumes that the server found ready 
for use when it started up. These are the volumes that users can 
access from their work stations. 

o The Users list shows the names of those users who are currently 
using the server. 

When a registered user accesses the server, the user's name is 
added to this list. When the user quits the server, the name is 
removed from the list. You can always find out how many users 
have logged on to the server. And because the name of each 
guest appears as "<Guest>, " you can also see how many guests 
are using the server. 

o The activity meter shows how much the server is being used at any 
moment. 
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As users access the server, save their work, or check access 
privileges-any activity that uses a volume on the server-the 
meter moves toward "busy." The number of users does not, by 
itself, affect the activity meter, but how they are using the server 
does. So if all users take their coffee breaks at the same time, the 
activity meter will show the server is close to "idle." 

Using the status window to improve service 

Here are two ways you can use the information in the status window 
to improve service to users on the network: 

o If you notice, in the Users list, the names of users who are not at 
their work stations or who are not using the server, remind them 
to log off. Users who are logged on but not using the server can 
affect the server's performance. If too many users are logged on 
but not using the server, other users may not be able to log on. 

o If you notice that the activity meter is always very busy, check how 
users are working with the server, and find ways to help them use 
the server more efficiently. 

If the server is constantly busy, you can suggest that frequently 
accessed applications be used from disks at work stations. 

Next, you'll display the AppleShare messages that were saved since 
you last started up the server. 

Checking AppleShare messages 

When you start up the server, AppleShare saves the messages that 
are displayed. These messages also include the time and date you 
started up the server. They can help you monitor the server and 
determine if there is a problem that may need to be checked. For 
example, if a volume was missing from the Volumes list, you could 
check the messages to see why. 
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l. Choose Show Messages from the File menu. 

The AppleSha re Messages window appears, with the list of 
messages saved since the server was last started up. 

s File 

Volumes : Server Name 
Sales & Mar,et1nq 

m 
lnternat1onal Sales 

Apple Share M ess ag es 

The Apple Share Server was sta rted at 
2 I 9 52 PM , Fri day , Sep tember I 9, I 986 . 

Checking vo lume "Internati onal Sales" ; this may take a 
minute .. . 
Checki ng vo lume "American Sales ··; this may take a 
minute ... 
2 va l id server vo l um es we re found . 

Ac\1v1ty 
',I, I,' Ir' 

ldle b•Jsy 

Scroll the list, if necessary, to see all the messages. If you find 
messages that you don't understand, see Chapte r 6, 
"Troubleshooting. " 

2. Close the AppleShare Messages window by clicking its c lose 
box. 

Once again, you see the server status window. 

Now you're ready to learn about the administrative tools that 
AppleShare Admin provides for monitoring serve r activity. 

58 Chapter 3: Keeping the File Server Running Smoothly 



Using AppleShare Admin reports 
While the server status window can help alert you that services need 
attention, you can use AppleShare Admin to create reports that 
help you decide what steps you need to take to improve those 
services. 

AppleShare Admin reports give you details about how the server is 
being used. They tell you about the server's users, groups, files, and 
folders. Creating reports periodically gives you an overview of 
server activity and helps you decide, for example, if you need to 
add more equipment. 

You can also use the reports to answer some questions users may 
have, such as what users are in a particular AppleShare group. 
Referring to the reports allows you to keep the server available over 
the network so you don't have to start up AppleShare Admin to find 
out who is in a group. 

Creating reports 
You can use AppleShare Admin to create two reports-the serve r 
report and the volume report. 

The server report lists all registered users and the groups that they 
are members of. It tells you how many files and folders each user 
has in a volume, and how much space these files and folders 
occupy. 

The volume report tells you several things about the folders in a 
volume: the names of the files and folders inside each folder; and 
each folder's owner, associated group, and access privileges. 

Both reports are available in two different versions, depending on 
how much information you want. You can choose either a complete 
report or a summary. To help you become familiar with what you 
can learn from these reports, you'll learn how to create a complete 
server report and a complete volume report. After you print these 
reports, you'll see what each report contains and learn the 
differences between a complete report and a summary. 
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1. Shut down the server. 

Choose Quit from the File menu, and in the dialog box that 
appears, enter the number of minutes until shutdown. You 
cannot enter fractions of a minute. Click OK to begin the 
countdown. 

For more information, see "Starting Up or Shutting Down the 
Server" in Chapter 4. 

2. Restart the Macintosh Plus with the App/eShare Server 
Installer disk, and open AppleShare Admin. 

After the countdown is finished and the server has shut down, 
insert the AppleShare Server Installer disk in the built-in disk 
drive, and click Restart. 

Open the Server Installer disk icon, if necessary, and open the 
AppleShare Admin icon. Type your Admin key and click OK. 

You're now ready to create reports. First, you'll create a complete 
server report. 

Creating a server report 

When you create a report, you'll save it on a 3.5-inch disk or in a 
folder on a server volume and then go to a work station to print the 
report. That way, you can quickly make the server available again on 
the network. 

•:• Note: If you save the report in a folder on a server volume, be 
sure you have the necessary access privileges to open the report 
and print it from your work station. 

1. Choose Server Report from the Server menu. 

A dialog box asks you to select the kind of report you want. 

2. Click the Complete Report option. 

A complete report may take several minutes to create, depending 
on how much information is stored on the server. If you've just 
set up the file server and users don't have many folders stored on 
it, the report will take only a short time. 
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[1iJ Please select the report you want: 

O Seruer Summary (users, groups) 

@ Complete Report (also uolume space used) 
(This may take seueral minutes) 

0£;J [ Cancel J 

3. Click OK. 

A dialog box appears, with the startup volume directory. 

4. Click Volume until you see the disk or volume on which you 
want to save the report. 

If you created the AppleShare Reports fo lder in Chapter 2, save 
the report there. 

The folder in which the report-----n--:~log~Ap~p~l~eS~h~a~r~e~R~e~po~r~t~sl~ 
wi ll be saved ~ 

Eject 
The volume where the report ----...;+----------""'' 

Uolume 
will be saved 

The name you type replaces -----
the selected name 

n Saue n 
( Cancel 

5. Choose the folder in which you want to save the report. 

You can save the report at the disk directory level. 

Or if the disk directory has folders, you can choose the folder 
where you want to save the report and open the folder by double
clicking. 

For more information about moving through the hierarchy of 
folders, see step 2 in "Creating a Folder" in Chapter 4. 
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6. Type a name for the server report. 

To keep a current record of server activity, you'll probably create 
a new report each time you use AppleShare Admin to update 
users or groups on the server. Give the report a name that renects 
the re port's type and date-for example "Complete Serve r 
Report 11/ 6/ 86." 

A report name can be up to 31 characters long. You can use any 
character except a colon (:). 

7. Click Save. 

A message tells you that AppleShare Admin is creating the 
re p o rt. 

Nex t, you 'll create a comple te volume report. 

Creating a volume report 

Creating the volume repo rt is si milar to creating the server report, 
except that you must specify the volume about which you want a 
repo rt. 

1. Choose Volume List from the Volumes menu. 

The Volume List window lists all active volumes on the server. 

2. Select the volume about which you want the report. 

Click the volume to select it. 

3. Choose Volume Report from the Volumes menu. 

You're aske d to select the kind of report you want. 
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4. Click the Complete Report option . 

Please seleL t the report you want for 
uolume " American Sales " : 

O Uolume Summary l folders, atcess priuilegesJ 

@Comple t e Rep or t (a lso f il es) 
(This may take seueral minu tes) 

'[OK- JJ (Cancel J 
~-~ 

5. Click OK. 

A dialog box appears that lets you save the report. 

6. Click Volume until you see the disk or volume on which you 
want to save the report. 

7. Choose the folder in which you want to save the report. 

As with the server report, you can save this report at the disk or 
volume directory level. Or if the directory has folders, you can 
choose the folder where you want to save the report and can ope n 
the folder by double-clicking. 

8. Type a name for the report. 

If you have more than one volume on the server, include the ty pe 
of report, the volume name, and the date as part o f the name . 
You may need to abbreviate the report name-for exa mple, 
"Am Sales CVR 11 / 6/ 86." 

A re port name can be up to 31 characters long. You can use any 
character except a colon (:). 

9. Click Save. 

A message tells you that AppleShare Admin is creating the 
repo rt. 
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If you saved the reports to a 
folder on a server volume. you'll 
need to log on to the server. 

Making the server available again 

Now that you've finished creating reports, quit AppleShare Admin 
so you can make the server available again. Then you can go to a 
work station, take a look at the reports , and print them. 

1. Choose Quit from the File menu. 

You return to the Finder. 

2. Choose Shut Down from the Special menu. 

The AppleShare Server Installer disk is ejected, and the server 
starts up again. Soon the server status window is displayed. 

Printing reports 

To open and print server reports, you'll go to a work station and use 
a word processing application. 

Follow the instructions for your particular word processor and 
printer. For best results, use a 9-point monospace font such as 
Monaco 9 point. 

•:• Note: You can format, edit, and print reports from any 
Macintosh-even one not on the server network-as long as it 
has a word processing application and a printer available. 

Taking a look at what's in server reports 

After you've printed your reports, you have two useful docu ments: a 
complete server report and a complete volume report. Take a close 
look at what each document contains. 

All reports, complete or summary, tell you the kind of report, the 
date and time it was created, the name of the server, and the 
custodian's name. 
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The server report also lists the server volumes (with space used and 
space available), gives a complete list of groups and their 
members, and tells you the following about each registered user: 

o user name and whether that user is allowed to log on to the server 
(that is, whether the Login Enabled option is checked in that 
user's information window) 

o the name of the user's primary group and other groups to which 
the user belongs 

o for each volume, the number of files and folders each user owns, 
and the volume space used by each user's files . There is also an 
entry for those folders owned by "<Any User>"-the folders 
created by guests . 

The server summary omits information about files and folder. 

Type of report -----------11----------- AppleSharn"" Complete Server Report 

Thursday, November 6 , 1986 
Date and time that the ------+------------ 1 : 39 : 32 PM 

report was created 

Users who logged on as -------11--.. 

guests created these files 
and folders 

The custodian is a registered - ---- 
user 

Server Name : Sales & Marketing 
Custodian Name : Alan 

Volumes : 

American Sales 3457K used , 15715K available 
I nterna tiona l Sales 24 41K used, 16730K a vailable 

<Any user> {Not a user) 
Space usage : 

Volwne : Ameri can Sales 47 K used for 7 files & 5 folders 
Vol ume: International Sales 37K used for 7 files & 7 folders 

l\lan (Enabled ) 
Primary Group : 

'Enabled" means the Login --------
Enabled option in the user's 

Groups : Marketing 
Space usage : 

Volume : American Sales 675K used for 48 files & 9 folders 
Volume : International Sales 112K used for 7 files & 4 folders information w indow is 

selected and the user can 
log on 

Bruce Enabled) 

Information about the user's ---- 1----1 
groups and the user's files 
and folders on each volume 

Primary Group : Western Region 
Groups : We stern Region 

Marketing 
Space Usage : 

Vo lume: Ameri can Sa les 218K used for 14 files & 1 folders 
Volume : Internationa l Sales OK used for 0 files & 0 folders 

Car rie (Enab led) 

At the end of the server report is 
an alphabetical list of groups 
and their members. 

Primary Group : Publica tions 
Groups : Publications 

Space usage : 
Volume: American Sa les 4 31K used for 27 files & 3 folders 
Volume : Internationa l Sales OK used for 0 files & 0 folders 
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Taking a look at what's in volume reports 

The volume report lists the following about the specified volu me: 

o the volume name, the space used and the space avai lable on that 
volume, and the date and time the volume was created, last 
modified, and last backed up 

o the name of each folder on that volume, with each fo lder's level 
in the hierarchy of folders 

o the name of the owner of the folder and the owner's access 
privileges 

o the name of the group, if any, whose members have access to the 
folder, and the group's access privileges 

o the access privileges to the folder for all file server users 

o the date each folder was created and last modified (omitted from 
the volume summary) 

o each file name, its level in the hierarchy of folde rs, the date it was 
created and last modified, and its size (omitted from the volume 
summary) 
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Type of report -----------+-----------AppleShare™ Complete Volume Report 

Date and time that the -------tt------------- Thursdayi :~~v~~~~ 6 , 1986 

report was created 
Server Name : Sales & Marketing 

Custodian Name : Alan 

Volume about which you ------+------... 
created the report Vol ume Name : Ameri can Sales 

Size : 34 57K used , 15715K ava ilable 
Created : Wednesday , September 1 7, 1986 at 2 : 55 PM 

Modified : Thu rsday , November 6 , 1986 at 1 : 18 PM 
Backed Up : 

The number shows the level ---------1 O)Folde r: American Sales (!America . nSa) 

in the hierarchy, w ith "O" g;~~~ Alan ~~i~ ~g~ ~~~ 
being the volume level Everyone : Fold File Chg 

Created : 9/17/86 Modified : 11/6/86 

All files and folders inside this ---- -------
[ l J Folder : '-Appl e Share Reports ( ! AppleSh. are J 

folder are listed next by Owner : Alan Fold rile chg 
hierarchical levels Group : 

Everyone : Fold File 
The owner of the folder and created : 9/18/86 Modified : 9/18/86 

the access privileges for each 
user category 

I 2J ~ · Am Sales CVR 11/6/86 (!AmSales . CVR) 
Cr eated : 11/6/86 Modified : 11/6/86 
Size : 2 1K 

Files and fo lders at the same ----+ -....,.1"""2'"'J__, ....... ~--Complete Server Report 11/6/86 (!Complet . eSe) 
level Of the hierarchy are Crea t ed : 11 /6/ 86 Modified : 11/6/86 

listed a lphabeti cally Size : 7K 

f l] Folder : Cu rrent Pro j ects (!Current Pro) 
Owner : Alan Fo ld File Chg 
Group : Fold 
Everyone : 
Created : 9/18/86 Modified : 11/4/86 

[ 2) Folde r : Eastern Region (!Eastern. Reg) 
Owner : Alan Fo ld File Chg 
Group : Fo ld File Chg 
Everyone : 
Created : 9/18/86 Modified : 11/5/86 

Using reports as guides to improving services 

You can use se rve r reports to help keep the server perfo rming as 
efficiently as possible and help you decide when to add new 
equipment or applications. Creating reports at regular intervals 
also gives you an overview of server activity that le ts you discover 
trends-how long before you'll need m ore volume space, for 
exa mp le . 

As you 'll see next, you can also answer questions that users might 
have about where informati on can be found and w ho ca n use it. 
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A pathway is a list of folder 
names that shows you how to 
go from the volume level to 
where a folder or file is located 
in the hierarchy. 

Answering users' questions 

Users want to know things like what groups they're in and who else is 
in those groups . With a server report in hand, you don't have to 
shut down the server and use AppleShare Admin to open a user o r 
group information window to find out the answer. 

Us ing the server and volume reports to answer certain user 
questions can save everyone time and trouble. 

Here are some questions that users frequently ask, togeLhe r wilh the 
name of the report most likely to supply the answer. 

o What groups am I a member op 

See the server report. Afte r the list of se rve r volumes, there is an 
alphabetical list of registe red users. Find the user's name, and 
under it will be the name of the user's primary group and other 
groups the user is a member of. 

o Can you tell me who are the members of a particular group? 

See the server report. At the end, you 'll find a list of groups and 
their me mbe rs. 

o Can you help me find my document or f older? IL 's disappeared! 

See e ither the complete volume report o r its summary to find a 
folder, or see the complete volume report to find a file. 

If the docu ment was in a folder to which other users had the 
privilege to make changes, the document could be rea lly 
gone---dragged to the Trash and erased, fo r example. O r maybe 
it was renamed. 

The document may be in a folder that the user is unable to see. 
Make sure that the user has the See Folders privilege to all the 
folders on the pathway from the volume level of the hie rarchy to 
the folder that contains the docume nt. The user must also have 
the See Files privilege for that folder. 

You can use any word processing application to search the 
volume re port for the name of the "missing" document. Then 
move back up the pathway and make sure that the appropriate 
privileges are available to the user at each leve l. 

Of course, there's one question that users will ask fo r which you may 
have no answer: What is my password? 
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To help ensure that passwords stay confidential so no one can have 
access to another user's private folders, the reports do not contain 
user passwords. (See Chapter 6, "Troubleshooting," for what to do 
about a forgotten password.) 

Now you'll see how the server reports help you organize what's 
stored on the server. 

Keeping volumes organized 

Volumes need to have folders and their contents organized so that 
users can quickly find information. When folders and files are 
clearly and appropriately named, users can easily find the 
information they need. When folders and files are logically 
grouped together, it's easier to find information about a given 
subject. 

As administrator, you can use the reports to see how information is 
being organized on the server volumes. 

o Check the complete volume report to see if the names of 
important folders and documents, particularly those to which 
everyone has access, indicate the contents. 

o Use the server report to see if users keep most of their folders and 
documents about the same subject together. 

o Use the volume report to examine access privileges. Help owners 
apply them consistently and at the proper levels of folders. 

Adding more equipment 

As the amount of available space on server volumes gets less and 
less, or as the number of users who regularly use the server 
increases, you may want to consider adding another file server to 
the network or adding hard disks to existing servers. 
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Before adding new equipment, make sure you rea lly need it. for 
example, don't just check the amount of space left on server 
volumes to see if you need a new volume. J\lso check how the 
current volumes are being used. Some ways to free up space arc: 

o Remove, or store elsewhere, outdated or unused documents and 
applications. Use the complete volume report to see when files 
were last modified. You might identify fil es that are no longer 
useful to their owners. Always check with Lhc owner before you 
move or delete a file. 

o Use the complete volume report to sec if users arc unnecessa ril y 
keeping multiple copies o f documents on the server. 

o Use the complete volume report to sec if many users keep the 
same applicalion in a private folder on the server. It may be 
more efficient to use one application that several users ca n open 
at the same time. 

•:• Note: Consult the copyright and lice nsing agreement for each 
application before making it avai lable to multiple users on the 
se rver. 

Using applications 

Users cai1 copy most applications Lo folders on the server and use 
them to create documents and store them on the server. Server 
performance depends on how often these applicati ons must access 
ervcr vo lumes . If many users simu ltaneously use applica lions that 

frcquenLly access serve r volumes, the server may be kept so busy 
that it performance is affected. 

See the AppleShare User 's Guide for more in fo rmalion on u ing 
applications with the server. 

70 Chapter 3: Keeping the File Server Running Smooth ly 



Keeping backup copies 
of what's on the server 

ow that you know how to use server reports, you need to consider 
how to protect server documents from loss due to disk failure or 
accidental deletion. 

fortunately, disk failures are rare, but people have been known to 
delete something, then regret it. It's crucia l that the users of your file 
server make it a regular practice to make backup copie of whatever 
they've stored on the server. In the case of system software or an 
application program, the orig inal 3.5- inch disk is an effective 
backup. \'(!hat you need to be concerned w ith is making backup 
copies o f documents. 

When a user save a document on the server for the last time during 
the day, the user could also save the document on a work ta lion 
disk. The AppleShare User's Guide has complete instru cti ons. 

There is also magnetic tape equipment de igned specifically for 
making high-speed backup of large disk volumes. 

The more oft en information is backed up, the more cun rmt the 
backup will be i f it 's needed. 

Important Backup copies are only as secure as the place where they're 
kept. If your information is worth a great deal - and whose 
isn't?-consider storing backups in a fireproof sa fe . 

In the event that you ever have to resto re a server volume from 
backup copies, you'll also have to use AppleShare Admin to 
prepare the volume for use on the server. 
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Saving users and groups 

In addition to backing up documents, it's also very important to 
back up the server's User & Groups file, as you did in Chapter 2. 
That way, if the Users & Groups file or the Server Folder on the 
startup volume is lost, you can use the backup copy when installing 
AppleShare. And you won't have to register users and create groups 
once aga in. 

For in tructions on saving a backup copy of the Users & Groups file, 
see "Backing Up Users and Groups Lists" in Chapter 2. 

Now you're ready 
Now you're ready to monitor the server to keep it run ning smoothly. 
Of course, some of the best information about what' happening on 
the server will come from the u ers themselves. Pay close auenlion 
to their comments and questions. 

You 'll also be doing other administrator tasks. New users may want 
lo sta rt using the server, or an office team may be formed to work on 
a special project and want to be listed as a group on the server. 
You' ll be updating lists and helping users to get access to the 
information they need. You may be installing concurrent server 
applica tions. When you need reminders about how to do these tasks 
and make cha nges to the server, Chapter 4, "Using AppleShare 
Admin," can help you. 
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Chapter 4 

Using AppleShare Admin 
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Installing AppleShare 
server software 

To install AppleShare 
software on the Macintosh 
Plu you 'll use as the file 
server, you must have set up 
the Macintosh Plus with one 
or more hard disks and must 
have connected it to t11 e 
Apple'falk Personal Network. 

ee "Sett ing Up Equipment 
for the Server" in Chapter 1 
for more in fo rm ation. 

You'll use the 1\ppleShare 
Admin application on the 
AppleShare Server Installer 
disk to prepare the hard disks 
as server volumes. \Xthen you 
finish, you ca n start up the 
Macinto h Plus as a file 
se rv e r. 

• ff you're going lo convert a 
current work station lo a 
server, relu rn to the Finder, 
choose Shut Down from the 
Special menu, switch off the 
Macintosh Plus, then switch 
off each hard disk. 

• If you're going to attach any 
uninitialized I Jard Disk 
20SCs, you must use the 
HD20SC Jnstaller application 
LO initialize each of them 
before going on to step 1. 

1. Switch on the hard disks, 
insert the SeNer Installer 
disk, and switch on the 
Macintosh Plus. 

You can switch on the hard 
disks in any order. After you 
switch them on, wait until 
tlley're up to speed before you 
switch on tlle Macintosh Plus. 

The icon of the Server 
Installer disk (tlle current 
startup disk) appears on the 
desktop. 

The icons of any previously 
named hard disks also 
appear. 

For each new Hard Disk 20, a 
dialog box asks if you want to 
initialize it. 

• Click OK to initialize the disk. 

• After the disk is initialized, 
type a name. Then click OK. 

Disk names can be up to 27 
characters long, and you can 
use any character except a 
colon (:). 

The icon and name of tlle disk 
appear on tlle desktop. 

A server hard disk is ca lled a 
volume. 
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2. Check the AppleTalk 
connection. 

• Choose Chooser from the 
Apple menu . 

• Click the AppleTalk Active 
option, if it's not already 
selected. 

• Close the Chooser by 
choosing Close from the file 
menu or by clicking its close 
box. 



3. Open the Server Installer 
disk icon and the 
AppleShare Admin icon. 

A dialog box lisLS the active 
volumes attached LO the 
Macintosh Plus . 

Note: Cl ick ing a finder 
bu tton always ca ncels the 
operation, quits AppleShare 
Admi n, and returns you to the 
Finder. 

Available volumes 

4. Click the volume you 
want as a startup volume, 
and click OK. Then click 
OK to prepare the volume. 

After you select the volume 
you want, a dialog box asks 
you to confi rm that you want it 
prepared for use with the 
se rver. 

After you click OK, 
AppleShare Admin creates a 
Server Folder on the startup 
volume and copies the 
necessary system and 
A ppleShare files to it. 

A dialog box appears, with 
the directory of the Server 
Fo lder. 

The startup volume must have 
a Users & Groups file in the 
Server Folder. 

5. Click New. 

AppleShare Admin creates 
the Users & Groups file in Lhe 
Server Folder of the sta rtup 
volume. 

A dialog box asks you to enter 
the serve r name and Admin 
key. You must enter this key 
each time you open 
AppleShare Admin on Lhis 
se rve r. 

AppleShare'M Admin 

lE No startup L•olume found. Please select a 
L•olume to be the file sen•er s startup uolume. 

- "" ' r ' 

~ -( Frnder l 
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6. Enter a server name 
and Admin key. 

• Type the server name, and 
press Tab. 

A server name can be up Lo 31 
ch aracters long. 

• Type the Adm in key. 

The Adm in key can be up to 
eight characters long. 

• Click OK. 

A dialog box asks you to 
confi rm what you entered. 

-

Caution: Write down the 
Admin key and keep it in a 
safe place. Each time you use 
the key to open AppleShare 
Admin on th is server, you 
must type it exactly as you did 
just now, with the same 
uppercase and lowercase 
characte rs. 

• Click OK to confirm w hat you 
entered, or click Cancel to be 
able to make changes. 

----
AppleShare'~ Admin 

~ Plea~e enter file ~en•er inf or mat1on 

Seruer Name S11 les ll' M11rketing 
, 
T 

Admin Key ses11 mEl 

~ r 
Find er ) 
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7. Click OK for each 
additional volume you 
want prepared. 

The volume named in the 
dialog box is prepared. 

Clicking Skip Volume cau e 
the volume to not be 
prepared. When you start up 
the se rver, any unprepared 
volumes will not be seen over 
the network. 

After the last volume is 
prepared (or ski pped), the 
AppleShare Admin menu bar 
appears w ith the User List and 
Group List w indows and the 
custodian's user informa ti on 
w indow . 

A dialog box tells you that the 
custodian w ill own all folders 
currcnlly w ithout owners, and 
you're asked to enter a 
custodian name and 
p assw ord . 

The server name you typed 

The Admin key you typed 



8. Click OK, and enter a 
custodian name and 
password. 

• EiLher type a new name or 
leave "CusLOdia n, " and Lhen 
press Tab. 

The name can be up to 31 
characters long. 

• Type a password up Lo eight 
characters long 

As you type, the cha racLers 
appear as large dots. 

Jf you think you 've made a 
typing mistake, use the 
13ackspace key to erase text, or 
select the text you want to 
corre ct and retype. 

Clicking Revert changes Lhe 
name and password back to 
how they first appeared. 

Write down the password and 
keep it in a safe place. If you 
use it to access the server from 
a work station, you must type 
it exactly as you did just now, 
with the same uppercase and 
lowercase characters. 

• Click OK. 

If you typed a new name, it 
replaces "Custodian" in the 
User List window. 

The server is now ready to be 
used if you want to make it 
avai lable to all users on the 
network. Users w ill log on as 
guests, and anyth ing they 
store on the server will be 
available to all users. 

s File Edit Users Groups Sen•er llolumes Folders 

n User LIS t :o User: Alan 
Jst,. fh f 

rJ ._J A e~ 
Nam e: liAlan I ,.-, ... ar 

Password: I •uu I 1:8:1 Login Enabl ed 

ll I OK ~ I HPIJPrt I 
Primary Group: [ J 

Group Lisi ,,.,.., I 

I I 

p "' • 

_t 

If you want to use AppleShare 
Admin to register users so 
they can use access privileges 
to control access to what Lhey 
store in folders, see 
"Registering a User" in this 
chapter. This chapter also 
contains procedures for 
doing oLher basic 
administrator tasks. 

• When you're ready to quit 
AppleShare Admin, choose 
Quit from the File menu . 

If you've entered some 
information you haven't 
saved, a dialog box may a k if 
you want to save it. For more 
information, see "Starting or 
Quitting AppleShare Admin " 
in thi chapter. 

• Before starting up the s rver, 
check Lhat Lhe Alarm Clock 
has Lhe correct date and Lime, 
and check the RAM Cache 
setting. 

See "Checking the Clock and 
RA.J\.1 Cache" in Chapter 1 for 
instructions. 

After you quit AppleShare 
Admit\ you can start up the 
server. For instructions, see 
"Starting Up or Shutting Down 
the Server" in this chapter. 
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Starting up or shutting 
down the server 

You can start up the file server 
when the equipment is 
switched off or from the 
Finder, usually after you 've 
quit AppleShare Admin. 

See "Sta rting o r Qu itti ng 
AppleShare Admin" in this 
chapter for more information 
about quitting AppleShare 
Admin . 

You w ill ometimes need to 
shut down the file server and 
use AppleShare Admin to 
make changes to server 
in fo rm ation-for exa mple, to 
register or remove users, to 
make changes ro the serve r 
groups, or to create server or 
volume reports. 

Shutting down the server takes 
it off the AppleTalk network. 
A t their work sta tions, logged
on u ers receive pe riodic 
warnings that the serve r w ill 
shut down. When the server 
shuts down, users who have 
not logged off may lose 
in formati on that they haven' t 
saved. 

To start up the server 

To start up the server when it's 
sw itched off: 

• Switch on each hard disk 
attached to the M acintosh 
Plus. 

You ca n switch on the hard 
disks in any order. 

• When the disks are up to 
speed, switch on the 
Macintosh Plus. 

AppleShare checks each 
volume and starts up the 
se rver . 
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To start up the server after 
quitting AppleShare Admin: 

• Check that the A larm Clock 
has the correct date and Lime, 
and check the RAM Cache 
setting. 

See "Checking the Clock and 
RAM Cache" in Chapter 1 for 
instru ctions. 

• Choose Shut Down from the 
Special menu. 

Any disk in the Macintosh 
Pius's buil t-in drive is ejected, 
and the se rver sta rts up. 

If the server won't start, a 
me sage usually tells you 
w hat's wrong. Sec Chapter 6, 
"Troub les hooting ." 

I f you used an application 
o ther than AppleShare 
Admin to make changes to the 
server volumes while the 
server was shut down, you 
may first need to open and 
qu it Apple hare Admin to set 
up the correct access 
pr ivi leges. 

Note: Once the server status 
w indow is displayed, turn 
down the screen brightne s. 



To shut down the server 

1. Choose Quit from the Fi le 
menu. 

A dialog box appears that lets 
you set the number of minutes 
until shutdown. 

The p reset number is "10." 

2. Enter the number of minutes 
unti l shu tdown. 

Either leave "10" or type a 
number from 0 to '1094 (about 
68 hours). You cannot type 
fractio ns o f a minute. 

3. Click OK. 

A dia log box displays the lime 
left, in minu tes and seconds, 
until shu tdown. 

Server Nome 
r r~ pt 1r 1 

Number of minut es 

until shutdown? 

~~:=J (f c 11n ce 1 J) 

Users see a warn ing message 
that the server will shut down. 
Warning messages are 
displayed every hour; du ring 
the final hour, the w arn ing is 
d isplayed every ten minutes, 
then at five minutes, two 
m inutes , and one minute 
before shutdown. Users 
cannot log on to the server 
during the five minutes before 
shutdown. 

Clicking Cance l stops the 
countdown and retu rns you to 
the server statu window. 
Users see a message that the 
shutdown procedure ha been 
ca nce led. 

Volumes 
err et• r ~ AJt' -i r er A ., 

u ers 
e ~1 

~ 

.,.,j 

" 
'"'t rr:... 

When the countdown ends, a 
dialog box appea rs on the 
server and at each w ork 
sta tion saying that the erver 
ha been shut down. 

At the server, clicking Restart 
sta rts up the Macintosh Plus. 

If you insert a startup disk in 
the built-in drive and cl ick 
Restart, the Macintosh Plu 
starts up from that disk. I f you 
don't inse rt a disk and click 
Restart, the Macintosh Plus 
sta rts up from the server 
startup volume. 

If you want to switch off the 
server, switch o ff the 
Macintosh Plus and then the 
hard disks. 

Warn ing: If you switch o ff the 
server withou t going through 
the shutdown procedure, 
information not saved to a 
volume or work station clisk 
may be lost. 
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Starting or quitting 
AppleShare Admin 

J\fter you use the J\pplcShare 
J\dmin application to prepare 
the server, you 'II use it to 
make changes to the 
server-for example, to 
register or remove users, to 
make changes to the server 
groups, or to create erver or 
volume reports . 

See "Insta lling AppleShare 
Server Softwa re" in this 
chapter for more informati on 
about the first time you use 
AppleShare Admin to 
prepare the server. 

To begin working with 
AppleShare Admin, you start 
the application from the 
Finder. When you finish , you 
quit AppleShare Admin and 
return to the Finder. 

To start AppleShare 
Admin from the Finder or 
after the server is shut 
down 

1. If necessary, insert the 
AppleShare Server Installer 
disk into the built-in drive, 
and open the disk icon. 

If the server is shut down and 
you see the dialog box with 
the Restart button, insert the 
disk and click Restart. 

If the server is switched off, 
switch on the hard disks, 
insert the disk in the built-in 
drive, and switch on the 
Macintosh Plus. 

2. Open the AppleShare Admin 
i co n. 

After AppleShare Admin 
looks for server volumes, a 
dialog box appea rs where you 
type the Admin key so you can 
use AppleShare Admin 

3. Type the Admin key, and cli ck 
OK. 

Type the uppercase and 
lowercase letters as you did 
w hen you first prepared the 
server. 

After you click OK, 
AppleShare Admin displays 
the menu bar and the User Li t 
and Group List windows. 

If you click OK and a message 
says you made a mistake, you 
have two more chances to 
type the key before you return 
to the Finder. 

Clicking Finder returns you to 
the Finder. 

Typed characters appear as 
large dots 

If you make changes to a 
server volume without using 
AppleShare Admin, you must 
make sure the access 
privileges are still set up 
correctly on that volume. 

AppleShare 'M ~ clmin 

-

-~ Sa les ll' Market ing 

Enter Aclmin Key: [····· ~ J 
n oK;J [ Find er ) 
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4. If you made changes to a 
server volume before sta rting 
Apple hare Admin, choose 
Volume List from the 
Volumes menu, select the 
volume name, and choose 
Verify Access Pri vi leges from 
the Volumes menu. 

l f necessa ry, scroll the I ist to 
find the volume. 

To select more than one 
volume, drag or Shift-cl ick 
through the list o f volume 
names. 

AppleShare Admin checks to 
make su re the access 
privi leges are set up correctl y. 

To quit AppleShare Admin 

1. If you make changes to a 
server volume with a de k 
accessory while using 
AppleShare Admin, choose 
Volume List from the 
Volumes menu, select the 
volume name, and choose 
Verify Access Privileges from 
the Volumes menu. 

If necessary, scroll the Ii t to 
find the volume. 

To select more than one 
volume, drag or Shift-cli ck 
through the list of volume 
names. 

AppleShare Admin checks to 
make sure the access 
privileges are set up correctly. 

s File Edit Users Groups Seruer lllli Folders 

User List 
Uolume ln_f_o _____ 'lr----

.'.1'.i'.'.1'.r'.''.l'.'''.'up I! 
D Any User Uolume Repo rt 
[] Alen •u::rnn-.: 
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tr L•ohmHi L.is1 

2. From the File menu, choose 
Quit. 

If there are no unsaved 
changes, you return to the 
Finder. Otherwise, a dialog 
box appears for each 
information window that 
contains unsaved changes. 

Clicking Yes (or pressing 
either Return or Enter) saves 
the changes in the active 
window. 

Clicking No quits from 
AppleShare Admin without 
saving the changes in the 
active window. 

Clicking Cancel retracts the 
Quit command. 

rl Vo lume Name '-----------''• 

l!1!1B••llll•l12S:~------------------+- Volume to be checked 
= lnlern el1onel Sel.. 

QJ Pr •ul.L I tl<ir-agerT 

m 
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m 
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Fie ,eerch [•evel 
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Registering a user 

With AppleShare Admin , you 
can set up a list o f registered 
users who can then set access 
pri vileges for their serve r 
folders and keep the fo lders' 
contents as private as they 
w ish. 

\'V'hen you register a user, you 
enter a user name and a 
password that only you and 
the user should know. To 
access the serve r from a work 
station as a registered user, 
the registered user must enter 
the same user name and 
password . 

See "Seuing Up fo lders \'(!ith 
Access Privileges" in Chapter 
2 for more in formation abou t 
how access privileges work. 

1. Choose Create User 
from the Users menu. 

A new u er information 
window titled "New User" is 
displayed. 

If necessary, see "Starting or 
Quitting AppleShare Admin" 
earli er in this chapter about 
opening AppleShare Admin. 

s File £d J 0 \er 

2. Type the user name, 
and press Tab. 

A user name ca n be up Lo 31 
characters long. 

User Informa tion window ---~=====;........,,. 

U\el LI\ t ~li:fD~' ~~~~~~N~e~w~U~se~r~~~~~~~ 

D 
01< [ Jll'IJPrt J 

Prim ary Group: 
~==========;;=; 

Group s: 
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3. Type the password. 

A password ca n be up to eight 
cha racter long. 

As you type, the cha racters 
appear as large dots. 

If you think you've made a 
typ ing mistake, elect the dots 
tha t represent what you've 
typed so far, then tart again. 

Clicki ng Login Enabled to 
remove the "X" prevents Lhe 
user from logging on to the 
se rver. 

Clicking Revert undoes what 
you entered or changed. 

4. Click OK. 

The name and password are 
saved on the server. 

The user name is listed 
alphabetically in Lhe User List 
w indow. The Lille of Lhe use r 
information window now 
includes the user name. 

With the name and password, 
a user at a work station ca n 
access the server as a 
registered user. 

Before you close the window, 
you can assign the user to one 
or more server groups or 
speci fy a primary group. Sec 
"Adding a User to a Group" in 
this chapter. 

• If you want to dose Lhe user 
information window, click i ts 
close box. 

If you try to close Lhe user 
information w indow before 
you've saved w hat you 
entered, a dialog box appears 
and lets you save your 
changes. 

Clicking Yes (or pressing 
c it.her Return or Enter) saves 
the changes, and Lhe window 
closes. 

Clicking o closes Lhc w indow 
w ithout saving Lhe changes. 

Clicking Cancel makes the 
window active again. 

file £d1t U\el\ Ci1oup\ Ser •e1 llolume\ Folder\ 

D 
User icon and name added to ------i Rex 
list of registered users 

User password you typed ------r=======t-;;;;:;::::;;:;;;;;~~=~~~~;;;;;;;;~==~ 

When selected. the user -----;-;=== ....... ----1---~--__:..--rz=::==============:r=::; 
named in the window can log Gro up s: 
on to the server 
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Creating a group 

You ca n create groups on the 
server (and assign registered 
users as members) so that the 
owner of a folder can specify a 
group with w hich to share the 
informati on in that folder. 
For example, by assigning 
access privileges for that 
folder to the Group category 
only, the owner shares the 
folder 's conte nts with only 
those users who are members 
of the group. 

Groups on the server usually 
reflect the working groups you 
find in your office . With 
AppleShare Admin, you ca n 
create groups on the server so 
that the registered users you 
assign as members ca n share 
information among 
themse lves . 

Each folder (or volume) on 
the server ca n have one group 
assigned for which the 
folder's owner may set access 
privi leges. The members of 
the group would then have the 
same acces privilege to the 
contents of the folder. 

See "Adding a User to a 
Group" in this chapter to 
assign users as members of a 
group you crea te. 

Also, see "Assigning a Group 
to a Folder or Volume" in this 
ch apter. 

1. Choose Create Group 
from the Groups menu. 

A new group information 
window titled "New Group" is 
displayed. 

If necessary, see "Starting or 
Quitting AppleShare Admin" 
in this chapter about opening 
AppleShare Admin. 

Group information window 

User LIS 
1_1;~r N~r-

[]]] D Ary User- Name: 
0 Alan 

D Brue e OK 
D r ri~ 

D ll'f 

M•m"'" I D GenP 

Group LIS t 
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2. Type the group name. 

A group name can be up to 31 
characte rs long. 

Clicking Revert deletes the 
name. 

Where you type the group's 
name 

Folde1 s 

roup 

[ B1~o er t ] 

11 



3. Click OK. 

The name is saved on the 
se rver. 

The group name is listed 
alphabetica lly in the Group 
List window. The title of the 
group information window 
now includes the group name. 

J3efore you close the w indow, 
you can assign users as 
members. See "Adding a User 
to a Group" in this chapter. 

o If you want to close the group 
information window, click its 
close box. 

If you try to close the group 
information w indow before 
you've saved w hat you 
entered, a dialog box appea rs 
and lets you save your 
changes . 

Clicking Yes (or pressing 
either Return or Enter) saves 
the changes, and the w indow 
closes. 

Clicking No closes the window 
without saving the changes. 

Clicking Cancel makes the 
w indow active aga in . 

• File [d1t Users Groups Seruer Uolumes Folders 
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Adding a user to a 
group 

Al l registered users are listed 
in the User List window. You 
ca n assign any of these, with 
the exception of "<Any 
User>, " to a group. If you 
assign a user to a group, that 
user will have whatever access 
privileges are ass igned to that 
group for a folder. 

To add a user to a group, you 
have to drag the u se r's icon 
into an information window 
or to another icon. 
AppleShare Admin lets you 
do this in several ways. 
However, you can't type u er 
names directl y into a list o f 
membe rs. 

You can see the members of a 
group in its information 
window, and you ca n see Ll1e 
groups of which a user is a 
member (up to 15 groups) in 
the use r's in formatio n 
window. 

You ca n also specify a 
primary group in a user 
information window. Then if 
the user crea te a folde r, the 
primary group au toma ti cal ly 
is assigned to that folde r as 
the group that has the access 
pri v ileges to it (if any), and 
the user becomes a member 
of the primary group. 

To add a user to a group 

• Drag a user icon from any 
place on the screen to a group 
icon in the Group List 
w indow. Or drag a group icon 
to a u er icon in the ser List 
window. 

You ca n drag icons from the 
User List window to icons in 
the Group List window, or the 
reverse. 

If necessary, di p lay the User 
List or Group List window by 
choosing User List from the 
Users menu or Group List 
from the Groups menu. 

• Or drag a user icon into the 
Members list in a group 
information window. Or drag 
a group icon into the Groups 
list in a user information 
window. 

When the rectangle is 
highlighted, relea e the 
mouse button, and the icon 
and name appear in the li t
meaning the user is now a 
member o f the group. 

Apple hare Admin 
automatically saves this 
informatio n on the server. 

To add a user to more than 
one group, drag or Shift-cl ick 
through a list of group names 
to se lect them before 
dragging the icons as a group. 

f or instru ctions about 
deleting a user from a group, 
sec "Removing a User From a 
Group" in thi chapter. 

s F1le~t Users Groups Seruer Llolumes Folders 
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To specify a primary 
group 

l. If necessary, display the user 
information w indow by 
double-click ing the use r icon 
or its name anyplace on the 
scree n . 

If you don't see the user icon 
and name you want, display 
the User List w indow by 
choosing User List from the 
Users menu. 

2. Drag a group icon from any 
place on the screen into the 
place for the primary group in 
the u er information window. 

When the rectangle is 
highlighted, release the 
mouse button, and the icon 
and name appear in the place 
for the primary group-and 
in the user's Groups li t, if it 
wasn't alrea dy there. 

AppleShare Admin 
automatica lly saves this 
in formation on the server. 

For instructi ons about 
removing or changing a user's 
primary group, see "To 
Remove a User's Primary 
Group" or "To Change the 
User's Primary Group"
both in this chapte r. 
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Removing a user from 
a group 

You remove a user from a 
group either by deleting the 
user from the Members list in 
a group information window, 
or by deleting the group from 
the Groups list in the user 
in formation w indow. 

You'll sometimes want to 
remove a user from a 
group-for example, if a user 
switches projects and no 
longer needs access to the 
folders to which members o f 
the group have access. 

Or perhaps a user is already a 
member of 15 groups (the 
maximum number) but needs 
to be assigned to yet another. 
You first must remove the user 
from one group before you 
add the user to a new group. 

a 
You can also remove the 
primary group specified in 
user's in fo rmalion window 
Then if the user creates a 
folder, no group is ass igne d 
to the folder. 

User t o be removed from the 
group named in the w indow 

To remove a user from a 
group 

1. If necessary, display the 
group or user information 
window by double-cl icking its 
icon anyplace on the screen. 

If you don't see the icon you 
want, display the User List or 
Group List window by 
choosing User List from the 
Users menu or Group List 
from the Groups menu. 

2. Select the user name in the 
group information window. 

OR 

Select the group name in the 
user information w indow. 

To remove a user from more 
than one group, drag or Shift
click group names to select 
them in the user information 
window. 

3. Choose Revoke Membership 
from the Groups or Users 
menu, whichever comma nd 
corresponds to the 
information window. 

The selected icon is deleted, 
and the user is no longer a 
member of the group. 

AppleShare Admin 
automaticall y updates the 
information on the server. 
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To remove a user's 
primary group 

1. If necessary, display the user 
in formation w indow by 
double-cl ick ing the user icon 
or i ts name anyplace on the 
screen . 

If you don't see the user icon 
and name you want, display 
the User List window by 
choosing User List from the 
Users menu . 

2. Select the name of the 
primary group by clicking i t. 

3. Choose Remove Primary 
Group from the Users menu. 

The prima ry group is deleted, 
and AppleShare Admin 
automatica lly updates the 
in formation on the server . 

However, the group is still in 
the Groups list in the user 
in formation w indow. 

If you also want to delete the 
group from the Groups list, 
follow steps 2 and 3 in "To 
Remove a User From a 
Group" in this section. 

• File Edit Group\ Setuer Uolume\ Folder\ 
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Removing a user or 
group from the server 

As users and groups in your 
offi ce change, you 'll need to 
remove them from, or add 
them to, the server. 

You remove a registered user 
from the server by deleting 
the user's name from the scr 
List window. Any folders 
owned by the user to be 
deleted must be ass igned to a 
new owner-the custodian or 
another registered user. 

You ca n also tempora ril y 
prevent a registered user from 
accessing the server by not 
allowing the user's name or 
password to be logged in. 
Because the user docs not 
have access to any owned 
folders, you don't have to 
reas ign the user's fo ld crs. 
Later, you ca n give the user 
access aga in or perma 
remove the user. 

nenLly 

a group, If you want to remove 
you delete i ts name fro 
Group List window. 

User selected to be the 
owner of the deleted us 
folders 

m the 

er's 

To remove a user from the 
server 

1. If necessary, display the User 
List window by choo ing User 
List from the Users menu. 

2. elect the user name in the 
User List window. 

3. Choose Delete User from the 
Users menu . 

A dialog box pre cnts a list o f 
all users except the user to be 
deleted and asks you to 
transfer to another user the 
ownership o f any folders the 
user to be deleted may own. 

Clicking Cancel retracts the 
Delete User command. 

4 . Select a user w ho will become 
the new owner of the folders, 
and click OK. 

• File £d1tJllmEl1 Groups Seruer u 

To select another user, scroll 
the list, i f necessary, to find 
the name, and click it. 

If you select "<Any ser>, " 
the folders will become 
avai lable LO any user with 
acce s to the erver. 

Click ing OK deletes the user 
from the User List w indow and 
from any in formation window 
in which the u er is l isted. The 
deleted user's folders are 
transferred to the owner hip 
of the selected user. 

If the deleted u er was the 
owner of a volume, that 
ownership is also transferred. 

User to be deleted 

lumes Folders 

User list z u~l?r' thrne 

D L 

Delete user "Ly .Cea " and reass ign fold er D L1 liiJ D t1 own ership to : 
D N 
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0 F Q Linda IQJ • Q Nancy 

~ ,-----. ( Cance l ) 
!---- Q Patri ck 

m Ea tern F'e11 ,,. 

m Pr·· d..ic I. r lar ai~err 
m Publ1c.:1t1ons 

m Re~e.:ir· n Devel 

m Soutrern Peg1•Jn 
I-m Western Reg•on 
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To prevent a registered 
user from logging on 

1. If necessa ry, d isplay the u er 
in formation w indow by 
double-cl icking the user ico n 
or its name anyplace on the 
crcen. 

If you don't sec the u er icon 
and name you want, d isplay 
the User Li t w indow by 
choosi ng User List from the 
Users menu . 

2. Turn off the Login Enabled 
oplion by clicki ng Login 
Enabled to remove the "X" in 
the check box. 

3. Click OK. 

The user remains in the Users 
List w indow but can 't log on to 
the server except as a guest. 
The user only has access 
privileges that all users have . 

• If you want to close the user 
informal.ion w indow, cli ck i ts 
close box. 

See step 4 in "Registering a 
User" in this chapter fo r mo re 
about clos ing an inform ation 
window. 

To remove a group from 
the server 

1. If necessa ry, display the 
Group List w indow by 
choosing Group List from the 
Groups menu . 

2. Select the group name in the 
Group List window. 

3. Choose Delete Group from 
the Groups menu. 

A dialog box asks you to 
confirm that you want to 

delete the se lected grou p. 

Clicking OK deletes the group 
from the Group List window 
and removes it from any 
information w indow in which 
it was listed. 

s File £d1t Users 

User List 

D .... r,.~ 'Iser· 
[i ,..J.;n 

D eru e 
D Carre 
D c1111 

D Ge1 e 

Research & De vel .. 
Sou thern Region 
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Group Lis1 

Clicking Cance l retracts Lhc 
Delete Group command. 

All users who were members 
of the group no longer have 
access privileges (if any) to 
the folders or volumes to 
which the group was assigned. 

Llolumes Folders 
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Creating a folder 

You ca n use AppleShare 
Admin to crea te folders on 
server volumes, set access 
privileges , and assign an 
owner and group. The folders 
you create must have a name 
and an owner. Then users w ith 
access privileges can open the 
folders from their work 
stations . 

See the AppleShare User's 
Guide for examples of special 
kinds of folders you can set up 
for users on the server. 

Remember that you can also 
log on to the server from a 
work station and create 
folders. This keeps the server 
available for other users . 

Caution: Do not shut down 
the server and use the Finder 
to create or change folders on 
server volumes, o r you may 
have trouble starting up the 
se rver. 

1. Choose File & Folder 
Info from the Folders 
menu. 

A dialog box appears with a 
list of folders and files in the 
current directory. 

The directory name appears 
above the list, and the name 
of the cu rrent volume appears 
to the right. The first folder or 
file in the list is selected. 

Click Volume to see the 
folders on another volume. 

Clicking Cancel retracts the 
File & Folder Info command. 
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2. Open the folder where 
you want to create a 
folder, and click New 
Folder. 

Select the name of the fo lder 
and click Open, or just 
double-click the name. 

Scroll the list, if necessa ry, to 
find the folder you want. 

To see a list of folders within a 
folder, open the folder. 

In this way, you ca n move 
down through the hierarchy 
of folders until you find the 
folder you want. 

To move back up the 
h ie rarchy, press the directory 
name and choose the folder 
you want, or choose the 
volume name to get back to 
the volume directory. 

You ca n also crea te a folder in 
the volume directory. 

After you click New Folder, a 
new folder in fo rmation 
window titled "New Folder" is 
disp layed. 



3. Type the name of the 
folder. 

A folder name can be up to 31 
characte rs long. 

Clicking Revert deletes the 
name . 

4. Assign an owner to the 
folder. 

• Drag a user icon from any 
place on the screen into the 
p lace for the owner name in 
the folder info rmation 
window . 

When the rectangle is 
highlighted, release the 
mouse button, and the user 
icon and its name appear 
there-meaning the user is 
now the owner of the folder. 

Before clicking OK to create 
the folder, you can set access 
privileges or assign a group. 
See "Reviewing or Setting 
Access Privileges for a Folder 
or Volume" and "Assigning a 
Group to a Folder or Volume" 
in this chapte r. 

s File £d1t Users Groups Seruer Uolumes Folders 

~D User list New Folder 
U.:-e-r Name 

5. ClickOK. 

If necessary, make the folder 
information w indow acti ve by 
cli cking inside it. 

After you click OK, the folder 
is created in the place you 
selected, and the title of the 
folder information window 
now includes the name you 
entered . 

When a user accesses the 
volume, the user will find the 
folder in the folder (or at the 
volume level) where you 
created it-if the user has 
access privi leges to that 
volume and folder. 

• If you want to close the folder 
in formation w indow, cli ck its 
close box. 

See step 4 in "Registering a 
User" in this chapter for more 
about closing an information 
w indow. 
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Assigning a group to a 
folder or volume 

You ca n ass ign a group Lo a 
folder or volume in a fo lder 
o r vo lume info rmation 
window. 

The group ass igned to Lhe 
folder or volume w ill have Lhe 
access privileges thar the 
owner may set by selecting the 
Group and Everyone options 
in the info rmal.ion window. 

See "Reviewing or Seuing 
Access Privileges for a f o lder 
or Volume" in thi chapter. 

To assign a group to a 
folder 

1. Choose File & fo lder ln fo 
from the Folders menu . 

J\ dialog box appears with a 
list of folders and files in the 
current directory . 

The directory name appears 
above Lhe Ji t, and the name 
of the current volume appea rs 
to the right. The first fil e o r 
fo lder in the list is se lected. 

Cli ck Volume LO see Lhe 
folders on another vo lume. 

Clicking Cance l retracts Lhe 
f ile & f older Info command. 

2. Se lect the folder Lo w hich you 
want to ass ign a group. 

Scroll Lhe lisr, if necessa ry, to 
find the fo lder you w ant. 

f or more info rmation on 
electing a folder in the 

hierarchy o f folders, see 
step 2 in "Creating a f older" 
in this chapter. 

3. Click Get Info. 

The in formation window of 
the selected folder is 
displayed. 
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4. Drag a group icon from any 1 . 

place on the screen into the 
place for the group name. 

If necessa ry, first display the 
Group List w indow by 
choos ing Group List from the 

2. 
Groups menu . 

\Xfhen the rectangle is 
highlighted, release the 
mouse button, and the group 
icon and name appear in the 
place for the group name-
meaning the members or this 
group have the access 
pri vileges set for the Group 
use r category. 

To assign a group to a 
volume 

Choose Volume List from the 
Volumes menu. 

The Volume List w indow 
appears with a list o f aclive 
volumes on the server. 

Select the volume to which 
you w ant to ass ign a group, 
and choose Volume Info from 
the Volumes menu , or just 
double-cli ck the volume 
name . 

The in formation window of 
the selected volu me is 
displayed. The ow ner of the 
volume is the custodian, 
unless the owner has been 
changed. 

s File £d1t Users Groups Sen•er llolumes Folders 
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3. Drag a group icon from any 
place on the screen into the 
place fo r the group name. 

If necessary, first display the 
Group List window by 
choosing Group List from the 
Groups menu. 

\Xfhen the rectangle is 
highlighted, release the 
mouse button, and the group 
icon and name appea r in the 
place for the group name-
mea ning the members of th is 
group have the access 
pri vi leges set for the Grau p 
user category. 
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Reviewing or setting 
access privileges for 
a folder or volume 

You ca n use AppleShare 
Admin to review or set acce s 
privileges for a folder or 
volume on Lhe server--even 
for ones for which you're not 
the owner. You do this in Lhe 
folder or volume information 
window . 

For more information about 
access privileges, sec "Using 
Access Privileges" in Chapter 
2, or see the AppleSha re 
User 's Guide. 

An ·x· appears for each 
selected option 

To review or set access 
privileges for a folder 

1. Display the information 
window of Lhe folder whose 
access privileges you w ant to 
review or set. 

Follow steps 1 and 2 in "To 
Ass ign a Group to a Folder" in 
this chapter. 

2. To set access privileges, cli ck 
the appropriate access 
pri vi leges for each user 
ca tegory. 

To remove a setting, click the 
option so its check box no 
longer contains an "X." 

Clicking Revert undoes the 
changes you've made since 
the last time you clicked OK. 

3. Click OK to save the settings. 

• If you w ant to close Lhc folder 
in formation w indow, cli ck iLS 
close box. 

An "X" appears in Lhe check 
box for each selected oplion. 

See step 4 in "Registering a 
User" in this chapter fo r more 
about closing an information 
window. 

----
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To review or set access 
privileges for a volume 

1. Choose Volume Lisr from the 
Volumes menu. 

The Volume List w indow 
appea~ witha Ii rofactive 
volumes on the erver. 

2. Select the volume whose 
access priv ileges you want to 
review o r set, and choose 
Volume Info from the 
Volumes menu, or just 
double-click the volume 
name. 

The information window of 
the selected volume is 
displayed. 

3. To set access privileges, click 
the appropriate access 
privi leges fo r each user 
category. 

An "X" appears in the check 
box for each selected option. 

To remove a setting, click the 
option so its check box no 
longer contains an "X." 

Clicking Revert undoes the 
changes you've made ince 
the last time you clicked OK. 

4. Click OK to save the settings. 

• If you want to close the 
volume in formation window, 
click i ts close box. 

See step 4 in "Registering a 
User" in this chapter fo r more 
about closing an info rmation 
w indow. 

To prevent guests from 
accessing a volume 

1. Create a new group and assign 
all registered u ers as 
members of that group. 

See "Creating a Group" and 
"Adding a User to a Group" in 
this chapter. 

2. Assign the group you created 
to the volume that you want to 
prevent guests from 
access ing. 

See "Assigning a Group to a 
Folder o r Volume" in this 
chapte r. 

3. Set the acces privileges to 
the volume so only the Owner 
and Group categories have 
access privileges. 

Make su re that no options for 
the Everyone ca tegory are 
selected . 

See "To Review or Set Access 
Privileges for a Volume" in 
this secti on. 

Only the owner and the 
members (all registered 
users) of the group named in 
the volume information 
window can acce s the 
volume. Guests have no 
access privi leges. 
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Changing a name, 
owner, group, 
password, Admin key, 
or access privileges 

You ca n use AppleShare 
Admin to respond to the 
changes in you r office and 
keep the server running 
smoothl y. You can change 
the name of anything on the 
server-a user name, a file, a 
folder, or a vo lume-even the 
name of the server. You ca n 
also change the Admin key as 
well as a user password. And 
you ca n specify a different 
primary group for a user or 
assign a new owner or group 
to a folder or volume. 

You ca n make most of these 
changes in va rious 
Apple~ha re information 
windows. 

To change a user name or 
password 

1. If necessary, display the use r 
in formation window by 
double-cl icking the user icon 
or its name anyplace on the 
screen. 

If you don't see the user icon 
and name you want, display 
the User List window by 
choosing User List from the 
Users menu. 

2. lf you want to change the user 
name, select it in the user's 
information window, and 
type a new name up to 31 
characters long. 

Or u e the Edit menu 
commands to edit the name. 
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3. If you want to change the 
password, select it and type a 
new password up to eight 
characte rs long. 

Clicking Revert undoes the 
changes you've made since 
the last time you clicked OK. 

4. Click OK. 

The changes are saved. 

lf you want to change the 
groups listed in the user 
information window, sec 
"Adding a ser to a Group" 
and "Removing a User from a 
Group" in this chapter. To 
change the primary group, 
see "To Change the User's 
Primary Group" in this 
sectio n. 



To change the name of a 
group 

1. If necessary, display the 
group's in fo rmation window 
by double-cl icking the group 
icon or its name anyplace on 
the creen. 

If you don't see the group icon 
you want, display the Group 
List window by choosing 
Group Li t from the Group 
menu. 

2. Select Lhe group name in the 
group's information window. 

3. Type a new name up to 31 
characte rs long. 

O r use the Edit menu 
commands to edit Lhe name. 

Clicking Revert undoes the 
changes you've made since 
the last Lime you clicked OK. 

4. Click OK to save the name. 

To change the user's 
primary group 

1. If necessary, display the user's 
information window by 
double-clicking the user icon 
or its name anyplace on the 
sc ree n. 

If you don't see the user icon 
you want, d isplay the ser List 
window by choosing ser List 
from the Users menu. 

2. D rag a group icon from any 
place on the creen into the 
place for the primary group in 
the user information window. 

\'V'hen the rectangle is 
highl ighted, release the 
mouse button, and Lhe ico n 
and name replace Lhe 
previous primary group. 

AppleShare Admin 
automat ically makes the 
changes on Lhe server. 

The previous primary group is 
sti ll in the Groups list. The 
new primary group is also 
added to the Groups list, if it's 
not already there. 

For instructions about 
deleting a user's primary 
group, see "Removing a User 
from a Group" in this 
chapter. 
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Changing a name. owner. group , password . Admin key. or access privileges 99 



To change the name of a 
file, folder, or volume 

1. To change the name of a file 
or folder, follow steps 1 
Lhrough 3 in "To A ign a 
Group to a fo lder" in this 
chapter-and select Lhe file o r 
folder whose name you want 
to change. 

OR 

To change the name of a 
volume, follow steps 1 and 2 
in "To Assign a Group to a 
Volume" in this chapter-and 
select the volume whose name 
you want to change. 

2. Select the name in the 
information window. 

3. Type a new name. 

Or use the Edit menu 
commands to edit the name. 

Clicking Locked in a file 
in formaLi on w indow prevents 
users from changing the file. 

Clicking Revert undoes the 
changes you've made since 
the last time you cli cked OK. 

4. Click OK. 

The changes are saved. 

For instructions about 
changing other information 
in a folder or volume 
in fo rmation window, see "To 
Change the Owner, Group, o r 
Access Pri vileges of a Folder 
or Volume" in this section. 
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To change the owner, 
group, or access 
privileges of a folder or 
volume 

1. To make changes to a folder, 
follow steps 1 through 3 in "To 
Assign a Group to a Folder" in 
this chapter-and select the 
folder whose owner, group, 
or access privileges you want 
to change. 

OR 

To make changes to a volume, 
follow steps 1 and 2 in "To 
Assign a Group to a Volume" 
in this chapter-and select 
Lhe volume whose owner, 
group, o r access privileges 
you want to change. 

2 . If you want to change the 
owner, drag a user icon from 
any place on Lhe screen inLo 
the place for the owner name 
in the folder or volume 
information window. 



\Xlhen the rectangle is 
highlighted, release the 
mouse button, and the icon 
and name replace the name 
of the previous owner. 

AppleS hare Adm in 
automatically makes the 
change on the server and 
transfers all current access 
privileges to the new owner. 

3. If you want to change the 
group, drag a group icon 
from any place on the screen 
into the place for the group 
name in the fo lder or volume 
information window. 

\Xlhen the rectangle is 
highlighted, release the 
mou e button, and the icon 
and name replace the name 
of the previous group. 

AppleShare Admin 
automatica lly makes the 
change on the server and 
transfers all current access 
privi leges to the new group. 

Ii. I f you want to change the 
access privileges of a folder or 
vo lume, cli ck the appropri ate 
access privileges fo r each use r 
category Lo select or deselect 
them, and click OK to save 
the setting . 

Cli cking Change All Enclosed 
Folders and then clicking OK 
causes any folders w ithin the 
folder o r volume to have the 
same owner, group, and 
access privileges as shown in 
the current in fo rmation 
window. 

Clicking Revert undoes the 
changes you 've made to the 
access privileges, but not to 
the owner or group. 

To change the server 
name or Admin key 

1. Choose Server Info from the 
Se rver menu . 

A dialog box appears with the 
server name and Admin key. 
The serve r name is elected. 

2. If you want to change the 
name, Lype a new server name 
up to 31 characters long, o r 
use the Edit menu command 
to edit it. 

3. I f you want to change the 
Admin key, press Tab Lo 
select the key, and type a new 
key up to eight characters 
l ong. 

4 . Click OK. 

If you changed only the server 
name, the name is ch anged. 

If you changed the Admin 
key, a dialog box ask you to 
confirm the new key by 
cli cking OK. 

To open AppleShare Admin 
again, you mu t type 
uppercase and lowerca e 
characters exactly as you 
typed them here. So write 
down you r Admin key and 
keep it in a safe place. 

5. Click OK to save the changes. 

Click ing Cancel return you to 
the server information box 
where you can make further 
changes. 
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Creating a volume or 
server report 

ApplcShare Admin lets you 
create reports about how Lhe 
server is being used. You ca n 
use Lhese reports to monitor 
server acliviLy and improve 
servi ces for the use rs. 

A volume report can tell you 
all about the folders and files 
in a volume-for example, 
how much space they use, 
who owns the folders, and 
what access privileges are se t. 

A server report ca n tell you 
about the users on the 
server-for example, what 
their names are and what 
groups they' re in . 

You can crea te a complete 
volume or server report or a 
ummary o f either. Sec 

"Using Reports as Guides to 
Improving Se1vices" in 
Chapter 3 for a de cri ption of 
what's in each kind or report. 

The report that's created is a 
tex t-only document Lh at you 
ca n sLore on a se rver volume 
or disk. J\t a work sLation, you 
can use a word processing 
application ro open and prinL 
the document. See "PrinLing 
Report " in Chapter 3 for 
more in format ion. 

To create a volume 
summary or complete 
volume report 

1 . Choose Volume List from the 
Volumes menu. 

2. Select the volume about which 
you want a report. 

3. Choose Volume Report from 
the Volumes menu. 

A dialog box lets you select 
the kind of report you want. 
The p reset option is Volume 
Summary. 

4. Click the option you want, if 
it's not already selected, and 
click OK. 

s Frie Edit Users &r oups Ser uer 

User list 

D 

A dialog box appears with a 
l ist of folders in the current 
direc to ry . 

5. Click Volume until you see the 
disk or volume on which you 
want to save the report. 

Clicking Cancel retracts the 
Volume Report command. 

6. Select Lhe folder where you 
want to save the report, and 
open the folder by double
clicking. 

You can also save the report 
at the disk level of the 
hierarchy. 

Folders 

[] ,:., [IiJ Pl ease se lec t th e repo r t you w ant fo r 
uolume " Ame rica n Sale s" : 

_, 

-
" -1 " I~ 

@ Uolume Summary ( fold er s, access pr iuil eges) 

O Complete Report (al so fil es) 
(Thi s may t ake seuera l minut es) 

[ Ca ncel J 
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For more information about 
sclecLing a folder in Lhe 
hierarchy of fo lders, sec slep 
2 in "Crea ting a Folder" in 
th is chapter. 

8 . Type a name for the report. 

Adding a vo lume name and 
date will help you dislinguish 
Lhe report from others. 

9. Click Save. 

The report is saved as a Lcx t
only document in the folder 
you selected (or at the disk 
level o f the h ierarchy). 

To create a server 
summary or complete 
server report 

1. Choose Server Report from 
the Server menu. 

A dialog box appears Lhat lets 
you select the kind of report 
you want. The preset oplion is 
Serve r Summary. 

2. follow steps 4 through 7 in 
"To Create a Volume 
Summary or Complete 
Volu me ReporL" in Lhis 
sec tion. 

" File Edit Users Groups SeruerJ LJio lFolders 

t-
User LIS t 

.. ,.rljr 

~ [61 Uolume Summarie sj D ,...,~ e 
[] 

"' " :' ln1Hrn<11ior1<1! '>111!~s ... lQ1 ! Reports 
r-

llolum 
( };.tect J 

I ~ 
"' Qj ( Uolume ) 

t ~ t 

Saue Uolume Summa ry fo r 
Ameri can Sa les as: [ Saue ] 
Ameri can Sa les I 0 /2~ ( Can cel J 

rn ~ J 

':IJ .. 
'-11 ~ .. " 
w • I-' t ... l 

ill .. I r .I I t--1 

The folder in which the report 
w il l be saved 

The d isk where the report 
w il l be saved 

The name you typed for the 
report name 
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Using a concurrent 
application on the 
server 

You can set up the server so 
that another server 
appl ication program runs on 
the server at the same time as 
AppleShare. Users on the 
network with access to the 
server will be able to share the 
services of this concurrent 
appli ca ti o n. 

You can install more than one 
concurrent appl ica ti on on the 
serve r, but only one can be 
made avai lable over the 
network at a time. After 
installing the application, you 
use AppleShare Admin to 
make it available o r remove it 
from the network . 

Caution: Install only 
applications specifica ll y 
designed to be used 
concurrently with the 
AppleShare server, or you 
may lose in fo rma tion. 

Follow the insLructions that 
come w ith the concu rrent 
applica tion if they arc 
different from these. 

To install a concurrent 
application 

1. Quit AppleShare Admin by 
choosing Quit from the File 
menu . 

For more information, see 
"Sta rting or Quitting 
AppleShare Admin" in this 
ch apte r. 

2. Open the server startup 
volume and the Server 
Fo lder. 

3. Eject the AppleShare Server 
Installerdisk by dragging it to 
the Trash. 

4. Insert the disk that contains 
the concurrent application 
you want to install. 

5. Open the disk icon and any 
folders you need to, until you 
see the application icon. 
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6. Drag the applica tion icon to 

the Server Folder of the server 
startup volume. 

7. Eject the application di k by 
dragging its icon to the Trash. 

ow you mu t start 
AppleShare Admin and make 
the application avai lable to 
users by following the 
instru ctions in "To Make a 
Concurrent Appli catio n 
Available or Change It" in this 
section . 

• To remove a concu rrent 
application from Lhe server, 
drag its icon from the Server 
Folder that's on the server 
startup volume to the Trash . 



To make a concurrent 
application available or 
change it 

J. If necessary, sta rt AppleShare 
Adm in. 

See "Starting o r Quitting 
AppleShare Admin" in this 
chapte r. 

2. From the Server menu , 
choose Enable Concurrent 
App li ca tion. 

A dialog box pre ents a list of 
the installed concurrent 
app li ca ti ons. 

3. Select the concurrent 
appl ication you want to make 
avai lab le. 

" File [di\ Users Groups [llll 

User LIS t 
U:er N3me 

0 ' 

4. Click OK. 

When you resta rt the server, 
AppleShare sta rts up the 
server and then opens the 
concurrent application. The 
server is still running and can 
be accessed over the network. 

The server status window will 
not, however, be available 
whi le the concurrent 
applica tion is running. 

Cl icking Cancel retracts the 
Enable Concurrent 
Application command. 

To see the server status 
window, quit the concu rrent 
appli ca tion . 

'.l Uolumes Folders 

[j A 

~ Se lec t a co ncurre nt appli ca tion : 
0 B 

-
0 ~ « name or eppl icetion» IQ [ OK l 0 ' It 
~ 

~ 
[ Ca nce l l 

r---1 

.H !J~· N;,1 ,.,. 

m E~ Xern Reg1·)n 
m Pr du t '1.;r a gen-
m PutJ1 ·.;t1~r 
m Resear :11 De el 
m p ter ri Peg1or 

H 

To remove a concurrent 
application from the 
network 

1. If necessary, sta rt AppleShare 
Admin. 

See "Starting o r Quitting 
AppleShare Admin" in this 
chapter. 

2. Choose Disable Concurrent 
Application from the Server 
menu. 

A dia log box lets you confirm 
that you want to remove the 
application from the network. 

3. Click OK. 

\Xlhen you restart the server, 
the concurrent application 
wi ll no longer be available to 
use rs. 

Clicking Cancel retracts the 
Disable Concurrent 
Appl ication command. 

Using a concurrent application on the seNer 105 



Chapter 5 

Reference 

107 



108 Chapter 5: Reference 

This chapter is an overview of what Lhe AppleShare file server is, 
how it works, and how you can work wilh it. It describes the 
equipment and software Lhat make up the file server. It tells you 
about the file server and AppleShare software wiLhout emphasizing 
how to use them or how to do things w iLh them. 

The first part of this chapter describes the AppleSharc server, 
including a brief discussion of ApplcShare volumes, system 
software, access privileges, using applica tions, and using Lhe server 
on interconnected AppleTa lk neLworks. 

The second part of this chapter te lls you abou t the menus and 
commands that you'll use Lo w ork with the server boLh w hen Lhe 
server i available on the network and w hen it is shut down. 

The AppleShare file server 
The AppleShare server that's now part of your AppleTa lk neLwork is 
a Macintosh Plus wiLh one or more hard disks (volumes) attached 
and is dedicated to providing file servi ce. The ApplcShare se rver 
software that's used with the Macintosh Plus enables it to offer access 
Lo its hard disks to all users on the network who use ApplcShare work 
station so ftware on their Macintosh Plus, Macintosh 512K 
Enhanced, or Macintosh 512K. 

As administrator, you r responsibiliLics in running the J\pplcSharc 
file se rver include: 

o setting up Lhc server equipment, which includes the MacinLo h 
Plus and one or more hard disks 

o connecting the server to the AppleTalk network 

o installing the AppleShare server software, wh ich includes Lhe 
AppleShare server application and related files 

o distributing the AppleShare Work Station Installer disk 

o registering users and entering passwords fo r them 



The fi le server' s hard d isks are 
called volumes. 

o organizi ng and crea ting groups on the se rve r 

o mainta ining the server 

Once the fil e serve r is available on the network and users have 
insta lled AppleShare on the ir sta rtup disks, they' ll use the Chooser 
to select a server, identify the mselves to the serve r, and se lect the 
server volume or volumes that they want to access. See the 
AppleShare User 's Guide fo r mo re information about how users log 
on to the se rve r and use it to sto re and share informatio n. 

File server equipment 

On the AppleShare fil e server, you must use a hard disk that works 
with the hie rarchical fil e system, such as the Macintosh Hard Disk 
20 and Apple Hard Disk 20SC. You can attach up to two Hard Disk 
20s plus seve n othe r hard disks that use a SCSI (Small Compu te r 
Syste m Interface) cable, such as the Hard Disk 20SC. 

The fil e server does not place any restri cti o ns on the size of the 
volume, so any hard disk that works with the hie rarchical fil e syste m 
ca n be attached to the Macintosh Plus. As a result, you ca n have 
several hundred megabytes of storage on a fil e se rve r, depending 
on the hard disk(s) you choose. 

The server is compatible w ith many hard disks manufactured by 
othe r companies. As a general rule, a highe r performance hard disk 
drive will e nhance the se rver's performance. See your autho ri zed 
Apple dea le r for furthe r informati o n o n hard disks that a re 
compatible with AppleShare. 

With AppleShare, a hard disk is where shared info rmati o n is s to red. 
The AppleShare serve r uses space on the hard disk very efficie nLl y 
because it does not partitio n the physical space on the disk for each 
use r. The AppleShare fil e se rve r dynamica ll y alloca tes and recla ims 
space as fil es are crea ted and de le ted. 
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AppleShare server software 
J\ppleShare server software consists o f: 

o the J\ppleShare Admin appli ca tion that installs J\ppleShare on 
th server and lets you work with information on the erve r w hen 
the server is shut down 

o the AppleShare server applica ti on and related files that the 
Macintosh Plus uses LO operate the server 

After you first start up the Macintosh Plus w ith the AppleShare 
Server Installer disk , you must use the Chooser to check th at the 
AppleTalk Acti ve option is selected. 

When you open the AppleShare J\dmin applica tion , it checks to see 
which vo lumes are attached to the Macintosh Plus and if they are 
ready to w ork as part o f the server. If you're opening J\ppleShare 
J\dmin for the fir t t ime, you must se lect a sta rtu p volu me so that 
AppleShare Admin ca n create a Server r a ider in w hich it installs 
AppleShare server so ftwa re-including the AppleShare se rve r 
applica tion and related files and the System file version 3.3 o r later. 
The Chooser is version 3.0 or later. After installing the softwa re, 
AppleShare Admin crea tes a Server Fo lder on each add itional 
volume and in each Server Folder crea tes a file that contains 
in fo rmation the server needs to operate. 

Important The server startup volume and all AppleShare startup disks at 
work stations must use System File 3.3 or late r, Chooser 3.0 o r 
later. and Finder 5.4 or later. You should check with your 
authorized Apple dealer to make sure you have the most 
current system software. 
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After you've insta lled server software, you must give a user, known as 
the cu stodian, a name and a password. This user becomes 
responsible for all fo lders that were on a hard d isk before it was 
prepared as a server volume. In additio n, w henever informatio n is 
incomplete abou t w ho crea ted and owns a folder, the server as. igns 
that fo lder to the custodian. 



You ca n then use the commands in the AppleShare Admin menus 
to organize in fo rmati on on the server, to provide for Lhe pri vacy of 
users' information, and to create reports of how users organize what 
Lhey store on Lhe server and how they share Lhat in formal.ion w ilh 
other users. You ca n register users , crea te groups, create folders, 
set access privileges, and crea te AppleShare reports . See 
"AppleShare Admin Menus" in this chapter fo r a complete 
description of the commands Lhat let you do this. 

At any Lime, you can quit AppleS hare Admin so the Macinto h Plu 
ca n resta rt using the server software on the sta rtup volume. 
l lowever, before you sta rt up Lhe server fo r Lhe first Lime, you must 
check that Lhe Alarm Clock has the correct da le and time and Lhal 
the RAM Cache is se t Lo the proper amount. Then you can sta rt up 
the server. (See "Using Desk Accessories With ApplcShare" in this 
chapter for more informati on.) 

The AppleShare se rver applicalion-along w ith its related 
files-makes it possible fo r the Macintosh Plus and the attached 
hard disks to sta rt up as a file server w ith server volumes. After Lhe 
server starts up, the AppleShare server applicalion disp lays a menu 
and a server status window Lhat shows current activity on the server. 
See "AppleShare Server Menus" in Lhis chapter for a descripti on o f 
the com mands. 

AppleShare windows and dialog boxes 

When you're using the ApplcSharc J\dmin applica tion or Lhe crvcr 
is ava ilable on the network , AppleShare displays different kinds of 
w indows as well as dialog boxes. 

AppleShare Admin windows 

When a window is displayed, you ca n rcpos ilion Lhe window by 
dragging i ts Litle bar, activate it by clicking in it, and close it by 
clicking its close box. If it has a scroll bar and size box, you ca n 
scroll the contents and resize Lhe window. You can also close all 
windows by choosing the Close All command from the File menu. 

ApplcShare Admin displays two main types of windows-list 
windows and in fo rmation windows. 
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There are three Ii t windows. The User List and Group Li t windows 
are automalically displayed when you open J\ppleShare Admin . 
They present lists o f registered users and groups whose names have 
already been entered and saved. The Volume List window is a list o r 
all volumes on the server. If you want to display a list window (or 
make it frontmost on the desktop), you can choose the List 
command from the corresponding menu. 

To work with an item in a list window, you c:in select it and then 
choose an appropriate command. Also, in the User List and Group 
List windows, you ca n drag an item (by dragging its icon) to another 
place to copy it there. You ca nnot edit or type in a list window. 

There are five inrormation windows. The user, group, or folder 
information window is displayed when you choose a command that 
lets you add a user, group, or folder to the server-or w hen you want 
information about a selected user, group, or folder already on the 
server. The file and volume inrormation windows give you 
information about a selected rile or volume. 

You ca n enter informalion or cha nge and review what's entered in 
an information window. Jn Lhe top panel or each inrormation 
window you enter or change information by typing and editing or 
by selecting and deselecling options. Clicking OK saves what you 
entered, or clicking Revert undoes the changes you've made since 
you last clicked OK. Except in the file info rmalion window, in the 
bottom panel you drag user or group icons to the appropriate 
places to enter them, and J\ppleShare Admin automatica lly saves 
the information. 

See "AppleShare Admin Menus" in this chapter for the commands 
Lhat you use to display these windows and work with them. for 
addilional information on using these windows and entering 
information, see Chapter 4. 

AppleShare server window 

AppleShare displays a server status window when you start up the 
server. The server status window lists volumes and cu rrentl y logged
on use rs and displays a meter that gauges current server aclivity. 



A guest is a user who logs on to 
the server w ithout a registered 
user name or password. 

Dialog boxes 

When you choose some commands, a dialog box asks you Lo type in 
information or se lect options Lo complete a command. You ca n 
sometimes confirm (or ca ncel) a command by clicking a buLton 
such a OK, Yes (or o, Cancel). Click ing the Finder button ca ncels 
an operation and retu rns you Lo the Finder. 

In dialog boxes with directories that let you open folders and move 
through the hierarchy of folders, you ca n alway open folders by 
double-clicking thei r name . 

Pressing Return or Enter is the same as cl ick ing Lhe buuon Lhat has a 
bold ouLline. 

How the server provides privacy 

You ca n use AppleShare Admin Lo register users' names and 
passwords on Lhe server to give those users personal control over 
their information. Registered users ca n use the Access Privileges 
desk accessory from their work stations to set access privileges for 
the folders they own on server volumes. \'<'hen a registered user 
crea tes a folder or moves an ex isting folder to a server volume, that 
user is the folder's owner. However, w hen users logged on a guesLS 
crea te folders, the owner is "<Any User>. " This means that all users 
wi th access to the file server jo intly own the folder and can change 
the access privileges at any time. (See Lhe AppleShare User's Guide 
for more information about guests using Lhe erver.) 

As the administrator, you can use AppleShare Admin to control the 
access to all in fo rmation on the server--even users' private 
folders-by being able to change the access privileges to any 
volume or folder on the server. You ca n also use AppleShare 
Admin to crea te or delete folders on the server, change the owner 
of a folder, or change a group associated with a folder. 

Access privileges 

Whether you use AppleShare Admin or a registered user uses the 
Access Privileges desk accessory to set or change access privileges 
fo r a folder, access privileges are give n and withheld in the same 
way and have the same effect. 
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When you use ApplcShare Admin to set access privileges for a 
folder, you do this in the folder's information window. You must 
determine what access you want to give to each of three user 
ca tegori es : 

o Owner 

Owner refers to the user who crea ted or was assigned ownership 
o f the folder. The owner is named in the folder's information 
window. 

o Group 

Croup refers to a group you created for users who usually have 
common interests and share information. The group (if any) is 
named in the folder's information w indow. 

o Everyone 

Everyone refers to any user with access to the server, whether 
logged on as a registered user or as a guest. 

You may assign to each of the three u er ca tegories any of three 
priv ileges: 

o See folders 

See Folders is the privilege to see fo lders contained wilhin the 
fo lder for which you are setting access privileges. Whether any of 
the folders withi n that folder may then be opened depends on 
the priv ileges that have been set for tho e folders. 

o Sec Files 

See Files is the privilege to sec the icons of documents and 
applica tions contained within the folder for wh ich you arc setting 
access privileges. See Files includes the privilege to open o r copy 
documents and appl ica tions. 

•:• Note: Certain appli ca tions may requi re the u er to have both 
See Files and Make Changes pr ivileges to work correctl y. Sec 
your authori zed Apple dea ler for more informati on about a 
parti cular appli ca ti on. 

o Make Changes 

Make Changes is the privilege to make changes to the contents of 
the folder-including moving or deleting the folder 's contents. 



Note that each p ri vilege is set independently o f the other p ri vileges. 
For example, the Make Changes privilege does not automati ca lly 
include the privileges to See folders and See f iles. 

13esides being able to change the access privileges in any folder 
information w indow, you ca n change the owner and group. You can 
open any folder's information w indow to review the folder's 
i n fo rm ati o n . 

You ca n also change the owner, group, and access p ri vileges fo r a 
volume. 

Using desk accessories with AppleShare 

fn general , you should not use any desk accessory on the server's 
Macintosh Plus. fn add ition , w hile using AppleShare Admin, you 
should not use any desk accessory that makes a change to a fil e 
serve r volume. 

There are only three desk accessories you may need to use from the 
Finder before starting up the server: the A larm Clock, the Choo er, 
and the Control Panel. 

Alarm Clock 

You use the Alarm Clock to set the date and time that is displayed in 
the server w indow. 

Chooser 

You use the Choose r to make sure that AppleTalk is set to Active. 

Control Panel and the RAM Cache 

You use the Control Panel to set the RAM Cache. The RAM Cache 
keeps frequently used in fo rmation in the memory of the se rver's 
Macintosh Plus so the in formation ca n be accessed quickl y w ithout 
having to return to the volume. In general, se tting the RAM Cache 
w ill improve the server's responsiveness over the network. 
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The recommended amount you may set for the RANI Cache is 64K . 
If you insta ll a concurrent server applica tion, it is recommended 
that you set the RAM Cache to Off unless otherwise specified in the 
documentation for the concurrent server application. The 
recommended amount of memory for the RAM Cache may be 
changed in later versions of the server softwa re. Check w ith your 
authori zed Apple dealer fo r more information about the RAM 
Cache setting for your server. 

Concurrent server applications 

You can set up the server to use another server applica tion that is 
available to users on the network at the same time that the server is 
available. You can install more than one concurrent server 
application in the Server Folder of the startup volume, but only one 
can be available on the network at a time. 

See you r authorized Apple dealer to find out which applica tions 
have been designed to be used concurrently with the AppleShare 
se rver appl ication. 

•!• Note: Users can also store applications on the server and use 
them from their work stati ons. See the rules for storing and 
using applications on server volumes in the AppleShare User's 
Guide. 

The server and interconnected AppleTalk 
networks 
To allow users on other AppleTalk networks to access the 
information that's on you r current file server, you must 
interconnect your network with other networks. 

A bridge (a combination of hardware and software) is used to 
interconnect your network and one or more other AppleTalk 
networks into one larger network. Bridges let you expand a single 
AppleTalk network both in the number of devices connected and 
the distance covered. 



The interconnected networks ca n be divided into zones, a group of 
one or more networks, not necessaril y adjacent, that have a 
common reason fo r sharing in formation. Zones let you organi ze 
users' access to info rmation by grouping the interconnected 
networks to make the best use of file servers and other network 
devices. For example, you may have a research department in t'\vo 
different buildings whose AppleTa lk net'\Vorks are part of a larger 
interconnected network but are not directl y connected to each 
other. If you group these !:'\Vo net'\Vorks as a zone, the !:'\Vo research 
groups ca n share information and network devices as if they were 
working on a single AppleTalk network. 

•:• Note: The AppleShare User 's Guide has information about using 
the Chooser to select a server in a zone. 

AppleShare Admin menus 
When you open AppleShare Admin, the menu bar provides the 
commands you need to manage the server, including registering 
users; making changes to users' names, passwords, and any groups; 
and getting information about and managing the server, its 
volumes, and its folders. 

Choosing some commands causes a dialog box or window to 
appear with places to enter in fo rmation, check options, and so 
forth. Once you've entered the appropriate information, you 
confirm the command by clicking the OK or Yes button in the box, 
or by pressing the Enter or Return key. Clicking the Cancel button 
ca ncels the command. 

A command appears dimmed w hen you ca n't use it-for example, 
most of the commands in the Volumes menu are dimmed unless Lhe 
Volume List window is d isplayed. 
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Apple menu 

File Edit U\e1 \ Group Se1t•er llolurne\ F olde1 \ 
About Appl eS h11re Adm in ... 

Al arm Clock 
C11 l cul 11 tor 
Chooser 
Cont r ol P11 ne l 
Key C11 ps 
Scrapbook 

About AppleShare Admin ... 

Shows the version number and the authors of the AppleShare 
Admin application, as well as other contributors to the 
development of AppleShare. 

s AppleShare' Adrnin 

'" 

p Jt ... t 

Desk accessories 

Choosing any of the desk accessories causes that accessory to 
appear. You can use the Edit menu to cut, copy, and paste the 
information in most desk acces ories. 

The desk accessories are explained more fully in " sing Desk 
Accessories With AppleShare" earlier in this chapter and in 
Macintosh Plus, your owner's gu ide. 



File menu 

s · £d1t U\er\ Group\ ~e1t•e1 llolume\ Folder\ 

Saue Users & Groups As ... 
Cl ose All 

Quit 

Save Users & Groups As ... 

Lers you save a backup copy of the server's lisrs of regi tered users 
and groups ( that appear in the User List and Group List w indow ) a 
a file on an AppleShare server volume or on a 3.5-inch disk. The 
Drive button lets you see the folders on another volume or disk . The 
Eject button lers you eject the disk in the built-in drive and in ert 
another one. You ca n also change where the lists are stored by 
se lecting the folder in which you want to save it, if any. 

You can change the name of the file in which the backup copy of the 
lisrs wi ll be kept by typing a new name. 

Close All 

Closes all windows that are displayed. 

Quit 

Leaves AppleShare Admin and returns to the Finder. 
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Edit menu 

Cut 3C H 
Copy 3C C 
Poste 3CU 
Cle or 

Group\ Ser t•er Ltolume\ Folden 

The Edit menu allows you to edit the names of volumes, documents, 
applications, or folders in their information windows. You ca n also 
edi t user passwords in user information windows. 

Undo 

Undoes your last text-editing action. 

Cut 

Removes the selected text and places it on the Clipboa rd, replacing 
the previous contents if any. 

Copy 

Places a copy of the selected text on Lhe Clipboard , replacing the 
previous contents if any. 

Paste 

Puts a copy of the contents of the Clipboard at the insertion point. 
You can continue to paste copies until you cut or copy a new 
selection, w hjch replaces the old contents of the Clipboard. 

Clear 

Removes the selected text, without placing it on the Clipboard. 



Users menu 

s File 
£d1t ··~' Groups Setuer Llolumes Folders _J 

Create User 

Create User 
Dele t e User 
User Info 

:l€U 

Remoue Pri mary Gro up 
Reu ok e M emb ers hip 

User lis t 

Displays a new information window titled" 1ew User. " In the top 
panel of the window, you ca n register a user on the server with a 
name (up to 31 characters long) and password (up to 8 characters 
long). You ca n prevent the user named in the window from 
acces ing the server as a registered user by deselecting the Login 
Enabled option. When you enter in fo rmation, the OK and Revert 
buttons are no longer dimmed. Cli cki ng OK saves the information 
you entered and lists the user name alphabetica lly in the User Li t 
window. Clicking Revert undoes any changes made since you last 
clicked OK. If you close the information window w ithout saving 
changes, you 'll be asked if you want to save them. 

In the bottom panel, you can ass ign a user to up to 15 groups. These 
groups are listed alphabetically. You ca n also specify a primary 
group that will automatically be the group associa ted wi th any folder 
the user crea tes. What you enter or change in the bottom panel i 
automatically saved. 
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Delete User 

Removes from Lhe server the user whose name you se lected in the 
ser Li l window. 

13cfore the user is deleted, you are asked to ass ign ownership of that 
use r's folders to another user. The custodian is automatically 
selected to be Lhe new owner. If you wa nt to give all Lhe folders to 
anoLher registered user, you ca n scroll through Lhe list and select 
anolher user. If you want to divide the folders beLween several other 
registered use rs, you should g ive Lhem to yourself. You 'll then have 
to use Lhe File & Folder Info command in Lhe Folders menu to review 
each folder and reassign ownership. If you want all users of the 
erver to jointl y own the folders, assign them to "<J\ny se r>." 

Clicking OK automatically remove that user from the User List 
window as well as from any folders or groups to w hich Lhe user w as 
assigned. The deleted user ca n log on to the server as a guest only. 

User Info 

Displays informalion about Lhe user whose name you selected in the 
U er Li t window. In this user information window, you can change 
Lhe user name or password as well as change groups. 

Remove Primary Group 

Deletes Lhe primary group you selected in the user's in formation 
w indow. That group i no longer automatica ll y associated w ith any 
folder that Lhe user creates. Deleti ng the primary group does not 
remove Lhe user's membership in that group. 



Revoke Membership 

Removes the user from the group(s) you selected in that user's 
information window. AppleSha re Admin automatica ll y deletes the 
group name in the user's in formation w indow and removes the 
user's name from the respective group's information window. If the 
group selected is also the user's primary group, the group i deleted 
both from the place fo r the primary group and from the Groups list 
in the user's information window. 

User List 

D isplays an alphabeti ca l list of all registe red users, including "<Any 
User>" and the custodi an ( indica ted by a special icon). You may 
display this list any time you want to delete a user or get in formation 
about a user. In addition, you ca n make a use r from the U er List 
window the owner of a folder or volume or a member o f a group. 
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Groups menu 

• File £d1t U\er\K!il!l!l!l'll Seruer Llolume\ Folder\ 

Create Group 3C G 
Delete Group 
Group Info 
Reu ok e M embership 

Group List 

Create Group 

Displays a new information window titled "New Group." In the top 
panel you can type a group name (up to 31 characters long). When 
you enter a name, the OK and Revert buttons are no longer 
dimmed. Clicking OK saves the name you entered and lists the 
group name alphabetically in the Group List window. Clicking 
Revert undoes any changes made since you last clicked OK. If you 
close the information window without saving changes, you'll be 
asked if you want to save them. 

In the bottom panel, you can assign any numbe r of users to be 
membe rs of this group. What you enter or change in the bottom 
pane l is automaticall y saved. 



Delete Group 

Removes from the server the group w hose name you selected in the 
Group List w indow. You're asked to confirm that you 're sure you 
want to delete the group. 

Clicking OK automatically removes the group from any place in 
w hich it is listed (the Group List w indow and any folders or volumes 
to w hich it has been assigned). Any access privileges previously 
ass igned to the group are no longer in effect until another group is 
assigned to that folder or volume. 

Group Info 

Displays information about the group you selected in the Group List 
w indow . In this group information window, you can change the 
group name and the members o f the group. 

Revoke Membership 

Removes from a group the user(s) you selected in the Members list 
in the group's information w indow. AppleShare Admin 
automatically deletes the users in the group and removes the group 
from the user information w indow(s). 

Group List 

Displays an alphabetica l l ist o f groups set up on the server. Display 
this list any time you want to review or change in formation about a 
group. In addition, you can ass ign a group from the Group List 
window to a folder or volume, or to a user's information w indow as a 
primary group or as a group of which the user becomes a member. 
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Server menu 

• File £d1t U\e1 \ Gt oup\ 

Server Info 

Llolume\ Folder\ 

Seruer Info 

Seruer Report 
£n11ble Con current Rppli c11 tion 
Dis11ble Concurrent Rpplit11tion 

Displays info rmation about the server. You ca n change the name of 
the server and change the Admin key for opening AppleShare 
Ad min . 

The characters of the Adrnin key appear as large dots until you type 
a new key. As you enter a new key, it appears as the characters you 
type. You are then asked to confirm the new key, and the characte rs 
you typed appear as large dots the next time you see the key. 

Server Report 

Lets you select one of two server reports-a complete re port or a 
summary. When you select and confirm which report you want, 
AppleShare Admin lets you choose where on a server volume (or on 
a disk) you want to save the report and lets you name the report. 

Whe n you click Save, AppleShare Admin crea tes the re port and 
saves it. (See Chapter 3 for a complete description of the contents 
of server reports.) 



Enable Concurrent Application 

Le ts you select a concurrent server application. This server 
application will operate at the sa me rime as the AppleShare server 
application. You must have previously installed a server 
application that is specifically designed to operate concurrently 
w ith the AppleShare server application. Otherwise, this command 
will be dimmed. See Chapter 4 for in fo rmation about using 
concurrent server applica tions. 

Disable Concurrent Application 

Lets you deselect a concu rrent server applica tion so that it does nor 
start when you start up the server. This command is dimmed if no 
concurrent server application has been enabled . Refer to Chapter 4 
for more information about concurrent se rver applications. 
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Volumes menu 

----
• File £d1t U\e1\ Group\ Seruer 

Remoue Group 

Uolum e Report 
Uer i fy Access Pri uil eges 

Uolum e Lis t 

Volume Info 

Displays information about the volume you selected in the Volume 
List window. 

When a server volume is prepared for use on the server, i ts name is 
the name you gave the hard disk, all access privileges are given to al l 
users, and the custodian is ass igned as the owner. 

In the top panel of the volume information w indow, you ca n change 
the volume name, change access privileges to the volume, and 
make all folders on the volume have the same access privileges. 
When you make a change, the OK and Revert buttons are no longer 
dimmed. Clicking OK saves the changes you made. Clicking Revert 
undoes any changes made since you last clicked OK. If you close the 
information window w ithout saving changes, you'll be asked if you 
want to save them. 

In the bottom panel, you ca n change the owner and assign or 
change the group. What you enter or change in the bottom panel is 
automatica lly saved. 

In the bottom panel, you'll see information about the volume's 
contents and the date and time that the volume was prepared and its 
contents last changed. 



Caution Using the Change All Enclosed Folders option replaces the 
owner. group, and access privileges specified for each fo lder in 
the volume with the information set up in the volume 
information window. You should seldom . if ever. need to do this. 
But if you do. be sure to notify each user who ow ns folders on 
the vo lume. 

Remove Group 

Deletes the group assigned to a volume. You must first open the 
volume information window and select the group assigned to Lhe 
volume before you ca n choose this command. The access 
privileges set for the Group category are no longer in effect until you 
assign another group. 

Volume Report 

Lets you select one of two volume reports-a complete report or a 
summary. When you select and confirm which report you want, 
AppleShare Admin lets you choose where on a server volume (or on 
a disk) you want to save the report and lets you name the report. 

When you click Save, AppleShare Admin crea tes the report and 
saves it. (See Chapter 3 for a complete description of the contents 
of volume reports.) 

Verify Access Privileges 

Checks access privilege information about the volume(s) selected in 
the Volume List window. AppleS hare needs this information to be 
complete to start up the server. If this information is incomplete for 
a particular folder, then the folder's ownership is transferred to the 
custodian. This command is not the same as the Access Privi leges 
desk accessory on an AppleShare work station startup disk. 

Volume List 

Displays an alphabetica l l ist of volumes on the server. This l ist must 
be displayed before you can use any of the other commands in the 
Volumes menu. 
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Folders menu 

s I 1le Edit U\et\ (jr oup\ ~ett•er llolume\ ·~·~·I· •----~ 
File If Folder Info ~F 

Remoue Group 

File & Folder Info 

Lets you display information about the file or folder you select, lets 
you create a new folder, or lets you delete a file or folder. 

Clicking Volume lets you see the folders on another volume. 
Clicking Open lets you open a selected fo lder in the list of folders. 

Clicking Get Info displays the information window of the selected 
file or folder. In a file information window, you ca n change the 
name of the file and select the Locked option so the file ca nnot be 
changed. In the top panel of a folder information w indow, you can 
change the folder name, change access privileges to the fo lder, and 
make all folders inside the folder have the same access p rivileges. 
When you make a change in the top panel of a file or folder 
information window, the OK and Revert buttons are no longer 
dimmed. Clicki ng OK saves the changes you made. Clicking Revert 
undoes any changes made since you last dicked OK. If you close the 
information window without saving changes, you 'll be asked if you 
want to save them. 



In the bottom pane l of the fo lde r info rma tion window, you can 
change the owner and change the group. What you change is 
automatically saved . 

In the bottom panel you 'll see info rmation about the date and time 
that the file o r folder was prepared and its contents last changed. 
For a file, you'll also see its size and on which volume it's stored. Fo r 
a fo lde r, you 'll see information about its conte nts . 

Clicking New Folder displays a new folde r info rmation window tiLled 
"New Folder. " You must enter a name and assign an owne r to be 
able to create the fo lder on the serve r. You can also set or change 
access privi leges and ass ign a group. Clicking OK crea tes the fo lde r 
and e nte rs information about the conte nts , and the date and time 
the folde r was created and last modified. 

Caution Using the Change All Enclosed Folders option replaces the 
owner , group, and access privileges specified for each folder in 
the folder with those set up in the folder information window. 
You should seldom, if ever, need to do this. But if you do, be 
sure to notify each user who owns any of the folders contained 
in the folder . 

Clicking Delete dele tes the se lected file or fo lde r afte r you confirm 
the command. 

Remove Group 

Deletes a group assigned to a folde r. You must first open the folder 
information window and select the group assigned to the folder 
before you can choose this comma nd. The access p rivileges se t for 
the Group ca tegory are no longe r in e ffect unti l you ass ign another 
group . 
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AppleShare server menus 
When you start up the server, the AppleShare server menu bar 
provides the commands you may need to use while the server is 
available on the ne two rk. 

Apple Menu 

ICI File £d1t Users Groups Seruer Llolumes Fold ers 
About AppleShare ... 

Alarm Clock 
Ca lculator 
Chooser 
Control Panel 
Key Ca ps 
Scrapbook 

About AppleShare ... 

Shows the ve rsion numbe r and the autho rs of the AppleShare server 
application, as well as other contributors to the deve lopment of 
AppleShare. 

ill • AppleShar e '" File Se1 t•e1 
".'J 

,pr e1 jN•ll ::Jfl n .1f'.' 11~n,:.,j tHJ P11 t, ,;.:,rid1,. ~.;tr 1 ~ ('Ir~ ::Jr1j 

•Jr l'llrf:>n 11H1J rift,:.n by i::1 t tH.,jr,.. ard Petn ~ [1r~ 

,...~pJ,..-~:irP .; rjio: 19r1,;-1j.;M ··1ttrinb1JJ;'1 t1Hr·1r~ P.:itn• (qr~ 

8ru,.. JIJ::J ;..l::in ppn1t1i:-1mi:-r _•tJr t11r.:tr S1•H11J ::Jfl•jC.:,:.•,i;-T1n ~.: 
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Desk accessories 

The sa me desk accessories that a re o n the AppleShare Server 
Installer disk appea r he re. 

Warning Do not install other desk accessories either in the System file in 
the Server Folder on the startup volume or in the System file in 
the System Folder on the App/eShare Server Installer disk. 

The Open command does not 
appear unless you used 
AppleShare Admin to enable a 
concurrent server application . 

File menu 

Sho w Messages 
Open « name of appl ication» 

Qu it ... 311 0 

Show Messages 

Displays a list of AppleShare messages about activity o n the 
serve r, as is descri bed in Chapter 3. 

Open <<name of application>> 

Al lows you to open a concurre nt server application and keep the 
server ava ilable on the network. Whe n you open the concurre nt 
server applica tion, it uses the screen, and the server status w indow is 
not displayed. You must quit the concurre nt serve r applicatio n to 
display the server status window aga in. This comm and does not 
appear unless a concurre nt server applica tion is e nabled. See 
Chapter 4 fo r information about using a concurre nt server 
applica ti o n . 

Quit ... 

Lets you ente r the number of minu tes until shutdown and start the 
shutdown procedure . Whe n the countdown ends, the server shu ts 
down. See "Sta rting Up or Shutting Down the Server" in Chapter 4 
ror de tails about the shutdown procedure. 
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This chapter will he lp you answer queslions that may arise when 
messages appear on the serve r screen or at work sta tions . It also 
includes a checklist to help you troubleshoot the AppleTa lk netwo rk 
if something goes wrong. 

General problems 

A volume is missing when you're going to select 
a startup volume while installing AppleShare 
file server software 

You are asked to select a startup volume fro m a list on the screen, 
and a volume (hard disk) that you know is attached to the server 
does not appear o n the list. Re turn to the Finder. Ile su re all the 
disks are initia lized according to the manufacture r's instru ctio ns. 13e 
su re all the volu mes that are attached to the server are turned on and 
up to speed before you switch on your Macintosh Plus as a serve r. 
Restart the AppleShare Admin program. 

A user has forgotten his or her password 
You ca n use the AppleShare Admin program to enter a new 
password in the use r's information window. 
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You have forgotten the Admin key 
If you forget the Admin key that you use while opening AppleSharc 
Admin and don 't have it written down, you 'll have to: 

Warning Before you use this procedure , make sure that you have a 
backup copy of the Users & Groups file . See "Backing Up Users 
and Groups Lists" in Chapter 2 for more Information. 

1 . Use the AppleShare Server Installer disk to start up the server's 
Macintosh Plus. 

2. While in the Finder, locate the sers & Groups file in the Server 
Folder of the startup volume, drag it to the Trash, and choose 
Empty Trash from the Special menu . 

3. Open the AppleShare Admin applica tion. 

4 . Select the same startup volume that you had before. 

5. When you're asked to se lect a Users & Groups file, se lect the 
backup copy of the Users & Groups file. 

Click Volume until you see the disk name. Click Eject to insert 
another disk . If necessary, open any folders in the list until you 
see the backup copy of the file. Se lect the file and cli ck Open. 

6. \'Vhen asked, type the server name and the new Admin key. 

7 . Continue to follow the procedure for preparing the server. 

See "Installing AppleShare Server Software" in Chapter 4 for 
more information. 
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AppleShare Srvr is the 
application fil e that turns 
the Macintosh Plus into a 
file server on the 
AppleTalk network . 

AppleShare messages 
AppleShare messages may appear on Lhe screen while you're 
starling up Lhe server or using commands from the erver's fi le 
menu- for example, choosing Lhe Show Messages command to sec 
Lhe !isl of saved sta rtup messages in Lhe AppleShare Messages 
window. 

The messages are !isled here in alphabet.i ca l order and followed by 
a few words of explanat.ion. If Lhe message Lelis you Lhere is a 
problem, a solut.ion is suggested. Messages that begin with a name 
thaL can change-for example, a specific volume's name-are 
listed la t. 

o An unexpected error was encountered determining a disk drive 
status. 

Switch off Lhe server's Macintosh Plus and all hard disks, and 
check that all the cables are connected properly. 

o AppleShare is not running from the startup volume's Server 
folder. 

Here are some poss ible causes: 

The startup volume does not work with the hierarchical file 
system. You will need to use a different hard disk, such as Lhe 
Apple Hard Disk 20SC, Lhat works wilh Lhe hierarchica l fil e 
system . 

The System file is not in the Seroer Folder on the startup volume. 
Start Apple hare Admin, which will copy Lhe System file to Lhc 
Server Folder. 

The AppleShare Sror file is not in the Seroer Folder on the 
startup volume. If Lhe AppleShare Srvr file is in another folder or 
if it is not on the volume, start AppleShare Admin , which will 
copy Lhe AppleShare Srvr file to Lhc slarlup volume. 

o AppleTalk is not Act.i ve. Please make AppleTa lk Active and 
res ta rt. 

se Lhe Chooser and select the AppleTalk Active option. 
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o A problem w as encountered examining volume "_''. Please 
contact your se rver administrator. 

Either the server has encountered a serious system problem or 
some files or folders w ere either added or deleted from the 
volume w hile the server was shut down. Start AppleShare J\dmin, 
and choose the Volume List command from the Volumes menu . 
Then select the vo lume named in the message, and choose 
Verify Access Privileges from the Volume menu. 

o J\ problem was encountered in trying to open the concurrent 
appli ca ti o n " __ ". 

J\ppleShare could not find the concurrent server application that 
w as reque ted. Make sure the concurrent applicaLion is in the 
Server Folder of the startup vo lume. 

o A problem w as encountered in trying to register the server's 
name . 

You may have given the server a name that already exi LS on the 
network or zone. Start J\ppleShare Admin and give the server a 
different name. 

o A version of the AppleShare POS file w as encountered which is 
incompatible w ith this version o f the AppleShare Srvr 
appli ca ti on . 

Your AppleShare PDS fi le ca n't be used with this version o f 
AppleShare. Start AppleShare J\dmin to correct it. 

o Checking volume "_ "; this may take a few minutes. 

AppleShare is checking a hard disk. How long this takes depends 
on how much info rmation the disk contains. 

o File Servi ce has been shut down. 

When you see this message, the server also sends a me sage to 
work station users that the server has been shut down. Any work 
no t already saved may be los t. 
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o ro startup vo lume found. 

AppleShare is looking for a va lid sLartup volume. SLart 
AppleShare Admin and either select a saved Users & Groups file 
or create a new one. 

o Registering the server's name on the AppleTalk network ... 

The server is being made part of the AppleTalk network, where iL 
will be known by the name you have given it. 

o The Desktop data base on volume "_" could not be opened. 

The Desktop Manager file is missing from Lhe Server Folder. 
Copy it from the System Folder on the AppleShare Seroer 
Installer disk to the Server Folder on Lhe sta rtup volume. 

o The number of minutes must be between 0 and 4094. 

You must type a w hole number. You can't type fractions of a 
minute. or can you type words, such as "Lwo." 

o There are two volumes wi th the name " 

Each server volume must have a unique name. Use AppleShare 
Admin to rename one of the volumes in i ts volume information 
window. 

o The system heap is too small. 

You may be trying to use too many hard disks. Start AppleShare 
Admin, and then quiL and restart Lhe server. If the problem 
persists, shut down the server, switch off the Macintosh Plus, 
switch off Lhe hard disks, disconnect one hard disk (any disk 
except your startup volume), and try starting up the server again. 
If the problem persists, see your authori zed Apple dea ler to make 
sure that the disk drive(s) you are using are compatible w ith 
AppleShare. 

o The Users & Groups file is damaged. Please sec your server 
administrato r. 

A problem was found w ith Lhe Users & Groups file. Start 
AppleShare Admi n and either select a saved Users & Groups file 
or crea te a new one. 
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o The version of the Users & Groups file is incompatible with this 
version of J\ppleShare Srvr. 

Your Users & Groups file can't be used with this version of 
AppleShare. Start AppleShare Admin and either select a saved 

sers & Groups file that is compatible or crea te a new one. 

o Time left until shutdown: 

When you see this message specifying the number of minutes left 
until shutdown, the erver sends a message about the shutdown to 
Macintosh work stations logged on Lo the server. The me sage 
tells users the date and lime the server is going to be shut down. 
I3efore shutdown, users should complete their w ork on the erver 
and save all changes to avoid los ing information. 

o " could not be used because it's in the internal or external 
drive. 

AppleShare can't use a 3.5-inch disk as a server volume. 

o " is not a valid I-IFS volume. 

AppleShare has encountered a volume (hard disk) that does not 
work with the hierarchica l file system (H FS). You cannot use this 
hard disk as part of the server. You will need to use a different 
hard disk, such as the Apple Hard Disk 20SC, that works w ith Lhe 
hierarchica l fil e system. 

o " is not a valid server volume. 

AppleShare has not prepared this volume for use with the server. 
Start AppleShare Admin to prepare it. 
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AppleShare Admin messages 
Most of AppleShare Admin 's messages are self-explanatory. The 
following alphabetica l list includes messages that may need a few 
extra words of explanation. 

o Disk 1/0 error. 

AppleSha re Admin doesn't stop, but the current operation 
between the Macintosh Plus and the disk is ca ncelled. 

o Memory is full. Close some open windows and try again. 

You may get this messages when too many w indows are 
displayed. (Managing windows takes up a lot of the memory o f 
the Macintosh Plus.) Close some windows, and try agai n to do 
what you were doing. 

o More than one startup volume was found. Please select the file 
server's startup volume. 

AppleShare Admin has found that more than one volume 
contains a Se rver Folder with a Users & Groups file, so you must 
select a startup volume. 

o No AppleShare volumes found. Press OK to return to the Finder. 

This message appears if the hard disks attached to the server do 
not work with the hierarchi ca l file system, or if the disks that were 
attached could not be accessed. 

o Replace the ystem file on "_ " with a newer System file 7 

The System file on the AppleShare Server Installer disk is newer 
than the System file on the server tartup volume. Start 
AppleShare Admin, which w ill replace the older file with the 
newer one. 

o Some access privilege in formation is incorrect. Please select this 
volume in the Volume List window and choose Verify Acee s 
Privileges. Then try this operation again . 

This message appea rs if you used the Finder to change something 
on a erver volume when the server was shu t down. 

o The file " " is locked. nlock and delete it? 
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This message appears if you try to delete a locked file, o r a folder 
containing a locked file , while using the dialog box that appears 
after choosing rile & Folder Info from the folders menu. 

o The file "Users & Groups" is in use. Please choose another file 
name. 

You tried to save the Users & Groups file to the Server Folder of 
the tartup volume (with the same name as the current file) , but 
you can't replace that file because AppleShare Admin is using it. 
Either type a different name or save it in another folde r. 

o The folder needs to have an owner. Please drag a user's icon to 
the place for the owner' name. 

This mes age appear if you are creating a new folder and try to 

save the information in the new folder information window 
without assigning an owner. 

o The name is too short. Please use a name with at least one 
chara cter. 

You ca n't leave the name blank. Type at least one cha racter th at 
is not a space. 

o The Users & Groups file on "_" is damaged. Do you want it 
fixed? 

This message appears when there's something wrong with the 
Users & Groups file. AppleShare Admin can fix it. 

o The user "_" can be a member of only 15 groups. 

If possible, remove the user from one of the 15 groups, and then 
you can add that user to another group. 

o The user "_" is already a member of 15 groups and cannot be 
added to group "_" . 

If possible, remove the user from one of the 15 groups, and then 
you ca n add that user to another group. 
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o This file is already open. 

You can't open the same file twice. 

o This file or folder is busy and cannot be deleted. 

You can't delete an open file or its folder. 

o This folder contains the Server Folder and cannot be deleted. 

You are not allowed to delete a folder containing the Server 
Folder. 

o This name is taken by a file of a different type. Please choose 
another file name. 

You tried to replace an existing file with a file of a different type. 

o This volume is full . 

Either try to use another volume, or delete some files and try 
again . 

o You cannot install the AppleShare file server on this computer. 

This message appears if AppleShare Admin is run on a 
Macintosh computer that has either 64K ROMs or less than 1 Mb 
of RAM. 

o You must save this file in the Server Folder of the AppleShare 
volume or on a 3.5-inch disk . 

The file referred to is the Users & Groups file . 
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Checking the AppleTalk network 
Here's a checklist from AppleTalk Personal Network, the guide that 
came with your AppleTalk System Connector Kit, for when 
something goes wrong with the AppleTalk network. For more 
details, see the guide. 

o Is the AppleTalk connector attached to the correct port? 

o Are the devices you're trying to use attached to the network? Are 
the devices switched on and ready? 

o Are all the devices you 're trying to use on the same network? 

o Check and tighten all AppleTalk connections. 

o Check for dangling cables. 

o Check for a ci rcular network . You can't connect the network in a 
circle. 

o If only one or two devices are having trouble, switch each device 
connected to the network off and back on. Make sure you follow 
the proper shutdown procedures if you're going to switch off the 
se rver. 

If you've sta rted up the server but one or more users can't find it in 
the Chooser after selecting the AppleShare icon, see the 
AppleShare User's Guide about checking the network. 

If you have a LaserWriter, also see Laser Writer and LaserWriter 
Plus, your owner's guide, for more information. 
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Glossary 

access privileges: The privileges given to or 
wiLhheld from users to open and m::i ke changes to 

a folder and its contcnLs. Through the selling of 
access privileges, you contro l accc s to the 
information LhaL's stored on the c rvcr. 

administrator: The person who sets up the 
se rver, registers users and Lhc ir passwords, creates 
groups, and ma inta ins the serve r. 

Admin key: A unique w o rd or set o f characters 
Lhat you must enter before you ca n open 
ApplcSharc Admin. The first time you open 
ApplcSha rc J\.dmin Lo install ApplcSharc server 
software, you choose Lhc Admin kc:y. 

AppleTalk connector: A piece o f equ ipment 
co nsisting o f a connection box, ::i sho rL cable, and 
a 9-pin or 25-pin plug that allows a device to be 
part of an ApplcTa lk network. 

AppleTalk Personal Netwo rk: The /\pplcTa lk 
co nnector , ca bles , cab le extenders, and softw are 
that link computers and periphcr::i l devices, such 
as printers or file servers, together in a 
communicat ion ncLwork . Sec ::i lso network. 

cable : /\n insulated bundle or wires with 
connccLOrs on the ends. An cx:implc is the 
ApplcTalk cab le. 

check box: A small box associated wiLh an 
oplion in a dialog box or window. When you click 
the check box, you may change the opLion or 
affect related o pti ons. 

Chooser: A desk accc sory Lhat you use to make 
sure the J\pplcTalk J\ clive opti on is se lected. AL a 
work stat ion, the Choo er is also used Lo access the 
serve r and any olher devices on the ApplcTa lk 
netwo rk . 

concurrent application: An application that 
runs on the server's Macintosh Plus at the same 
time as the J\pplcSharc serve r applica ti on and 
provides a se rvi ce to u crs on Lhc network. 

connection box: J\ small box al one end of an 
ApplcTa lk connecto r. Cables plug into the box, 
allowing network signals Lo f1ow through iL. 

connector: A plug, sacker, jack, or port. Sec also 
AppleTalk connecto r. 

custodian: The "user" who beco mes the owner of 
the prepared c rvc r vo lumes and any folders 
already on them. Ownership of una igncd fo lders 
is give n to the custodian. The administrato r 
choo cs Lhc custodian name and p::issword and 
ca n use Lhcm to log on from a w ork station just as ::i 
registe red user docs. 
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desk accesso ry: A "mini -ap pli ca tion" th at is 
available from the Apple menu rega rdless of which 
appli cati on you're using. 

device : In this guide, any p iece of equipment that 
ca n be attached to a network-a Macinto h, a 
Lascr\Vritc r, a fil e se rve r, o r other peripheral. 

directory : A p icto ri al, alphabe ti ca l , o r 
chronologica l list o f the co ntents o f a fo lder, disk , 
or vo lume. 

document: Whatever you crea te w ith applica tio n 
programs-info rmation you enter, modify, v iew, 
or sa vc . Sec also file . 

Everyone: The u er category to which you ca n 
ass ign access privileges for any user w ith access to 
the server, whether logged on as a registered user 
or as a guest. 

file : Any named, ordered co llec tion o f 
informatio n sto red on a disk . Documents, 
applica tions, and system files on disks are fi les. 

file server: A combination of Ap pleShare 
software, a M acintosh Plu s, and one or more hard 
disks, which allows users to store and share 
documents, fo lders, and applica ti ons over the 
AppleTalk network . 

group: A named collection of one or more 
registered file server use rs. Groups are crea ted for 
users w ho usually have common interests and 
share inform ati on . 

Group: The user category to w hich you can assign 
access privileges for members o f groups you 
crea tc. 

guest: A user who is logged on to the server 
without a registered use r name and passw ord. A 
gues t cannot own a folder. 
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hard disk: A d isk permanentl y sca led in to a drive 
such as the Macintosh Hard Disk 20. A hard disk 
ca n store large amounts of information compa red 
to a fl oppy disk. 

installation: The process o f addi ng informa tion 
to a hard disk to prepare it a a server volume. You 
use AppleShare Admi n to install serve r softwa re on 
the hard disks attached to the Macintosh Plus. Sec 
also startup volume. 

log off: To disconnect a work statio n from a 
server, usually by d ragging any serve r vo lume 
icons to the T rash. 

log on: To access a server from a w ork station and 
identify yoursel f. You ca n then use a vo lume on 
the server. 

Make Changes: The access p ri vilege that gives 
the right to make changes to a folder's contents. 

network: A system consisting o f computer and 
other devices, connectors, cab les , and 
appropriate so ftwa re that al lows the computers 
and devices to communica te with each other. 

owner: The registered fil e server user who 
crea ted or was assigned ownership o f the fo lJer. 
The owner is named in the folder's information 
w indow . 

Ow ne r: The use r ca tegory to w hich you ca n 
ass ign access privileges to the owner o f a folder or 
vo lume. 

password: A unique word or set of characters that 
must be entered before a registered user at a w ork 
station ca n access a volume on the se rver. 

pathway: The list of fo lder names that shows you 
how to go from the volume level to w here a fo lder 
or fi le is loca ted in the hierarchy. Also, the pull 
down list in a dialog box that shows the volume 
and fo lders opened to get to the current fo lder 
direc to ry. 



primary group: The group that you specify in a 
user's information window as the group with whom 
the user will most often be haring documents 
stored on the server. When a user creates a fo lder, 
the p rimary group is au tomatica lly named as the 
group that will receive any accc privileges set for 
the Group ca tegory. cc also group and Group. 

RAM Cache: RAM you can designate to store 
certain information that the Macintosh Plu ' fi le 
sy tern uses repeated ly. At present, 64K is the 
recommended amount for the Apple hare server. 
You set the RAJ\11 Cache in the Control Panel. 

registered user: A user who has been given a 
user name and password by the administrator. 

See Files: The access privilege that g ives the right 
to open and copy documents and applica tions in a 
folder. 

See Folders: The access privi lege that gives the 
ri ght to sec folders w ithin a folder. 

server: cc file server. 

Server Folde r: A fo lder created by AppleShare 
Admin on each vo lume. It contains information 
the server needs to operate. The crver folder on 
the startup volume al o contains the files that the 
server needs for sta rting up. 

server report: A document created by 
ApplcSharc Admin that gives you information 
about the server. It lists registered users and the 
groups they' re members of and includes 
in formation about how many folders and files a 
user has and the spa ce they occupy. 

shutdown: The temporary closing o f the file 
server so it's not avai lable on the network . 

starn1p volume: A volume with all the system 
and ApplcS harc files that the server needs for 
tarting up. 

volume: A hard disk that's attached to the file 
server. A volume has a name and a volume 
di rectory with the same name. 

volume report: A document crea ted by 
Apple hare Admin tha t tells you abou t the folders 
in a specified volume, such as the names o f files 
and fo lders, their owners and groups , and acce 
privileges. 

work station: A Macintosh that you ca n use to do 
your work and send or rece ive in formation over a 
network. ApplcSharc work stations are connected 
to the ApplcTalk Pe rsona l Tctwork. 

zone: A group of one o r more ApplcTa lk 
networks in a y tern of interconnected AppleTalk 
networks. 
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